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Chapter 1 

Basic Interaction with HyperMesh 
Section 1: Getting Started with HyperMesh 
In this section, you will explore the basic layout of the HyperMesh 9.0 user interface.  
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Overview of Finite Element Analysis 
 

Finite Element Analysis was first developed over 60 years ago as a method to 
accurately predict the reaction of complex parts to various inputs.  Prior to the development 
of FEA the only way to validate a design or test a theory was to physically test a part.  This 
was and still is both time consuming and expensive.  While FEA will never replace the final 
physical testing and validation of a design, it can drastically reduce the time and money 
spent on intermediate stages and concepts.   

FEA in its infancy was limited to large scale computing platforms but the 
development of powerful personal computers combined with intuitive software packages 
such as HyperWorks have brought FEA to the engineers desktop and has broadened its use 
and accuracy many fold. 

Finite Element Analysis is now a vital and irreplaceable tool in many industries such 
as Automotive, Aerospace, Defense, Consumer Products, Medical, Oil and Gas, 
Architecture and many others. 

FEA is performed in three stages, Pre-Processing, Solving and Post Processing and 
those are outlined below. 

Step 1: Pre-Processing 
Pre-Processing is the act of preparing (meshing) a model for analysis.  Complex 

geometry is broken down into simple shapes (elements) in the act of meshing.  This allows 
the solver in the next step to predict the action of these elements and analyze the reaction of 
a complex part to external forces and interactions.  The part is meshed and then definitions 
for the type and thickness of the material(s) are added then forces and constraints are 
applied.  The model is then prepared for the analysis with information the solver will need to 
perform its calculations.  The model is then written in a format that the solver can 
understand and is sent to the solver for processing. 

 

Step 2: Solving 
Solving is performed by any of the many commercially available software written to 

perform Finite Element Analysis.  Some of these include popular packages such as 
Radioss, Nastran, LS-Dyna, Abaqus, Ansys and a few others.  The solver takes the 
information provided in the file (input deck) created in HyperMesh in step one and calculates 
the parts reactions to the inputs defined.  Common outputs are Displacement, Stress, Strain 
and Acceleration.  These results are stored in a file that then can be read in HyperView in 
the Post-Processing stage. 

 

Step 3: Post-Processing 
 Post-Processing is where the results of the solver solution can be reviewed.  
HyperView can provide presentation quality color contoured plots and animations 
highlighting any of the requested results.  Information can be queried, displaced and even 
graphed in numerous windows allowing for customization geared toward the desired 
audience. 
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HyperMesh Introduction 
Starting HyperMesh 

• On PC 

o From the Start Menu, select All Programs>Altair 
HyperWorks(version)>HyperMesh. 

Or 

o User can create a Windows Shortcut by Right Clicking on the above program 
and selecting Create Shortcut. 

• On UNIX 

o At the prompt, type <install directoy>/scripts/hm. 

o Set up an alias. 

 

The Start Directory 
The “Start Directory” or “Working Directory” is where HyperMesh, by default, looks for and 
saves the following files; 

o Configuration files (hmmenu.set, hmsettings.tcl, hm.mac, etc.) 

o History File (command.cmf) 

o HyperMesh Model Files, FE Data and Geometry Files. (User can browse to 
different directories for opening and saving.) 

The Start Directory can be defined as follows: 

 On PC 
1. Right Click Shortcut link 

2. Select Properties 

3. Enter the desired directory in the Start In field or leave blank to default to 
directory where the shortcut is located 

On UNIX 

• The Start In directory will default to the Directory where the program is 
executed from.  If the configuration files are not found in that directory, then 
HyperMesh will look in the users “home” directory. 

Online Help 
HyperMesh offers comprehensive documentation in the online help.  The Help can be 
accessed through the Pull Down menu or the use of the “h” key on your keyboard.  If the 
user accesses help through the use of the “h” key the help documentation is “intelligent”, 
opening in the section representing the panel that the user is actively in.  Help also contains 
detailed tutorials on many advanced HyperMesh functions. 
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HyperMesh Graphical User Interface 

 
 

• Graphics area – displays the model 

• Toolbar – gives access to commonly used tools via icons 

• Pull Down Menu – places functionality into groups, accessible via pull downs 

• Menu Pages – divides the main menu into groups based on function 

• Main Menu – contains “panels” grouped in columns 

• Panels – menu items / functions for interacting with HyperMesh 

• Sub-panels – divides panel into similar tasks related to panel’s main function 

• Command Window – lets the user type in and execute tcl commands 

o Available through the View drop down menu (turned off by default) 

• Tab Area – contains the following tabs: 

o Solver, Model, Utility, Include, Import, Export, Connector, Entity State, etc. 

• Status Bar – shows status of operations being performed 

o Indicates the “current” Include file, Component Collector, and Load Collector  
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Section 2: Opening and Saving Files 
Bringing data files into HyperMesh and saving them are frequent operations every user 
should understand. This section will help you become proficient with the various ways this 
can be done in HyperMesh. The remaining exercises in this course will assume you know 
how to open and save files in HyperMesh. 

In this section, you will learn how to: 

• Open a HyperMesh file 

• Import a file into a current HyperMesh session 

• Save the HyperMesh session as a HyperMesh model file 

• Export all the geometry to an IGES file 

• Export all the mesh data to a RADIOSS input file 

• Delete all data from the current HyperMesh session 

• Import an IGES file 

• Import a RADIOSS file to the current HyperMesh session 
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File Operations 
  New .hm File – Creates a new session in the current window 
 
 Open .hm File – Loads a HyperMesh model into the current 

window replacing the current model 
 
 Save .hm file – Saves the current model, opens browser window. 
 
 Import – Opens the Import Tab allowing the import of; 

 .hm Models  FE Models Geometry Files Connectors 
into the current model. 
 

 Export – Opens the Export Tab allowing the export of: 

 FE Models Geometry Files .h3d Files Connectors 
Opens a browser window. 

 
 Load User Profile – Opens the User Profile Window. 
 
 Load Results File – Loads a result file for post processing within 

HyperMesh. 
 
 Open Current Command File – Opens a window displaying the 

current command.cmf file.  Can be used to learn TCL/Tk 
commands and create macros. 

 
 Run TCL Script/Command File –  

 Left Mouse Click opens a browser to load and run a TCL file. 

 Right Mouse Click opens a browser to load and execute a 
command.cmf file.
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Exercise: Opening and Saving Files 
This exercise uses the following model files: bumper_cen_mid1.hm, bumper_mid.hm, 
bumper_end.iges, and bumper_end_rgd.fem.  Each model file contains various 
sections, That will be assembled into the full bumper model. 

Step 1:  Open the HyperMesh model file, bumper_cen_mid1.hm. 
1. Access the Open File… dialog in one of the following ways: 

• From the Pull-down menu, choose File, then Open 

• From the Standard toolbar, click Open .HM File  

2. Open the model file, bumper_cen_mid1.hm.  

The model file, bumper_cen_mid1.hm, is now loaded. This file contains mesh and 
geometry data. 

 

 
HyperMesh model file, bumper_cen_mid1.hm, opened in HyperMesh 

Step 2:  Import the HyperMesh model file, bumper_mid.hm, into the current 
HyperMesh session. 
1. Access the Import tab in one of the following ways: 

• From the Pull-down menu, choose File, then Import. 

• From the Standard toolbar, click Import . 
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2. From the Import tab in the tab area, choose the HM Model icon from the selection. 

3. Under File selection, click the Open  and browse to select the file, 
bumper_mid.hm.  

4. Click Import.  

The file, bumper_mid.hm, is now imported into the session.  

  
HyperMesh model file, bumper_mid.hm, imported on top of existing data in the HyperMesh 
session 

Step 3:  Import the IGES geometry file, bumper_end.igs, into the current 
HyperMesh session. 

1. From the Import tab in the tab area, choose the Geometry icon . 

2. Under File selection, choose File type: Iges from the pull-down menu. 

3. Under File selection, click the Open icon  and browse to select the file, 
bumper_end.iges.  

4. Click Import.  
Geometry data is added to the model.  



Chapter 1: Basic Interaction With HyperMesh 

HyperWorks 10.0  HyperMesh Introduction 9 
Proprietary Information of Altair Engineering, Inc. 

 
 IGES geometry file, bumper_end.igs, imported into the session  

Step 4:  Import the RADIOSS Bulk Data input file, bumper_end_rgd.fem, into 
the current HyperMesh session. 

1. From the Import tab in the tab area, choose the FE Model icon . 
2. Under File selection, select File type: RADIOSS (Bulk Data) from the pull-down menu. 

3. Under File selection, click the Open icon in File: and browse to 
bumper_end_rgd.fem. 

4. Click Import. 
This RADIOSS input file contains mesh for the bumper’s end portion. The mesh is added 
to the existing data in the current HyperMesh session and will be located in the same 
area as the geometry representing the bumper’s end. 

  
RADIOSS input file, bumper_end_rgd.fem, imported on top of data in the current HyperMesh 
session  
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Step 5:  Save the HyperMesh session as a HyperMesh model file called 
practice.hm. 
1. From the File pull-down menu, select Save As...  

2. Enter the name, practice.hm. 

3. Click Save. 

The data currently loaded in HyperMesh is now saved in a HyperMesh binary data file of 
the name you entered. 

Step 6:  Export the model’s geometry data to an IGES file called 
practice.igs. 
1. Access the Export tab in one of the following ways:  

• From the Pull-down menu, choose File, then Export. 

• From the Standard toolbar, click Export . 

2. In the Export tab, choose the Geometry icon . 

3. Under File selection, File type: should indicate Iges. 

4. Under File selection, click the Open icon in the File field, browse to the desired 
destination folder, and enter practice.igs. 

5. Click Save. 

All of the geometry loaded in HyperMesh (points, lines, surfaces) is now saved in an 
.iges file with the name you entered. 

6. Click Apply to export the file. 

Step 7:  Export the model’s mesh data to a RADIOSS Bulk Data input file called 
practice.fem. 
1. In the Export tab, choose Export type: FE Model from the pull-down menu. 

2. Under File selection, choose File type: RADIOSS (Bulk Data) from the pull-down 
menu. 

3. Under File selection, click the Open icon in the File field, browse to the desired 
destination folder, and enter practice.fem. 

4. Click save. 

All of the finite element data loaded in HyperMesh (nodes, elements, loads, etc.) is now 
saved as an .fem file with the name you entered. 

5. Click Export. 
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Step 8 (Optional):  Delete all data from the current HyperMesh session. 
1. Access the delete New HyperMesh Model function in one of the following ways: 

• From the Pull-down menu, click File, then New... 

• From the Standard toolbar, click New .hm File  

2. Answer Yes to the pop-up question "Do you wish to delete the current model? (y/n)".  

Step 9 (Optional):  Import the IGES geometry file you created, practice.igs. 
Refer to Step 3 for detailed instructions. 

Step 10 (Optional):  Import the RADIOSS Bulk Data input file you created, 
practice.fem, into the current HyperMesh session. 
Import practice.fem into the current session. The data in the file will be added to the 
existing data in the current HyperMesh session. Refer to Step 4 for detailed instructions. 

With the completion of Steps 8, 9, and 10, your current HyperMesh session should contain 
all of the geometry and mesh data that existed in the HyperMesh session that was saved to 
a HyperMesh file in Step 5. 

Step 11 (Optional):  Save your work. 
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Section 3: Working with Panels 
Much of the functionality in HyperMesh is centered around the use of panels.  While there 
are often many ways to get to a function within HyperMesh, most often the actions lead the 
user to the panel area to select entities, enter values and execute functions.  The panel area 
is split into seven pages and on each page are panels that allow the user to utilize all of the 
functionality in HyperMesh.  Even if the user accesses a function through the use of the 
menu bar or the toolbars, much of the information will be entered in the panel area.  While 
this manual cannot explain the functionality of every panel, much of the panel functionality is 
common amongst all of the panels and thus learning one panel will assist the user in the use 
of all panels. 

This section introduces you to common panel attributes and controls as it guides you 
through translating nodes and elements using the translate panel and measuring distances 
between nodes using the distance panel. 

In this section, you will learn how to: 

• Use the entity selector and the extended entity selection menu to select and unselect 
nodes and elements from the graphics area. 

• Use the direction selector to define vectors along which to translate nodes and 
elements. 

• Switch between different entities to select, and methods to define vectors. 

• Toggle between two options. 

• Enter, copy and paste, and calculate numbers. 

• Use the rapid menu functionality to execute commands with the mouse buttons 
rather than clicking buttons. 

• Interrupt, but not exit, a panel to go to another panel using the keyboard function 
keys. 
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Panel Layout 
In HyperMesh, panels have three general layouts. The Basic Panel, Panel with Sub-Panels 
and Panels with Sub Panels organized in Columns.  Their look and functionality will be 
described below. 

• The Basic Panel 

 
Translate Panel 
 

• Panel with Sub-Panels 

 
Project/to plane Panel 

 
• Panel with Sub-Panel and Columns 

 
Surface Edit/trim with surfs/planes  
 
Generally panels are used in a Left to Right manner and those with columns are used in a 
left to right and top to bottom manner using the following steps: 
 
Step 1: “What to Do” 
This step only applies to panels with Sub Panels.  The user picks the functionality within the 
panel that is desired by picking the appropriate Sub Panel radio button.  The example below 
is from the Project panel and the “to plane” sub functionality is chosen. 

 
 
Step 2: “Method to Use” 
This step only applies to Panels with Sub Panels that are organized in columns.  Often, Sub 
Panels are organized into different columns when there are more than 7 Sub Panel options.  
The column organization groups like functionality together in instances where the entire 
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panel is not needed for information entry.  In this case the user picks the Sub Panel in Step 
1 and then chooses the method they wish to use within that sub panel and follows the 
column top to bottom.  The example below shows the Surface Edit panel with the trim with 
surfs/plane sub functionality chosen.  You can see the three columns providing access to 
either the “with plane”, “with surfs” or “self intersecting surfs” options. 

 
 
Step 3: “What to do it to” 
In this step the user will select the entities they wish to perform the function on.  The entity 
selction is shown below.   

 
 
Step 4: “How to do it” 
In this step the user defines parameters that dictate how the function will be performed. 
 

  
 
Step 5: “Do the action 
Clicking the green “action” button performs the desired function while the “Reject” button will 
reject the last performed function. 

  
 
Tools within the Panels 
Within the panels there are many buttons and options that will be explained below: 
 

Switches -   
These allow the choice of multiple options through a pop up menu 
 

Toggles -   
The toggle will change the function between 2 options. 
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Reset -   
This will reset the selection of any entities. 
 

Extended Selction -   
Clicking the yellow selection button will open the extended selection window.  This provides 
numerous tools allowing for the advanced selection of entities. 

 
 
 
Direction/Plane Selection -  

• X, Y, Z Axis -  
 

  
 

• N1, N2 and N3 -   
• Select 2 Nodes (N1 & N2) – This defines a directions from N1 to N2 where a 

vector type direction is required.  When a plane is required the plane is defined 
as that which is normal to the vector N1 to N2 and its location at the B node. 
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• Select 3 Nodes (N1, N2 and N3) – This defines a plane whose normal defines a 
direction when a vector direction is required.  Positive of the normal is defined by 
the “Right Hand Rule.”  In the event a plane is required the plane is that which is 
created by the three nodes with its location at the B node. 
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Exercise: Using the Translate Panel 

Step 1:  Retrieve the HyperMesh model file, bumper.hm. 
1. Access the File panel in one of the following ways: 

• On the File menu, click Open 

• On the toolbar, click the open icon  and go to the hm file sub-panel 

2. Click retrieve... and browse to <install directory>/tutorials/hm/bumber.hm 

3. Click Open. 

Step 2:  In the translate panel, select nodes from the graphics area. 
1. Access the translate panel in one of the two following ways: 

• From the Pull-down menu, select Geometry or Mesh and then choose 
Translate>nodes  

• From the Tool page, access the translate panel. 

2. With the nodes selector active, select a few nodes from the Graphics area by left-
clicking the corners of the elements. 

 
Node selector  

The cyan border around it indicates that it is active; HyperMesh is expecting nodes to be 
selected as the next action.  

A node is positioned at each element corner. A selected node is highlighted with a small, 
white circle. 

 
 

Node Handles 
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3. Reset the selection of nodes by clicking the reset icon, .   
Step 3:  Select and unselect elements from the graphics area. 

1. Click the entity selector switch ( ) and select elems. (Switch the entity selector to 
elems.)  

  
Entity selector with its switch 

The menu that pops-up contains a list of entities that can be translated.  

2. With the elems selector active, select several elements from the graphics area. 

To select an element, click its element handle (the dot at the element’s center). 

The elements are highlighted in white when they are selected. 

 
Element Handles 

3. Unselect an element using the right mouse button. 

Step 4:  Select and unselect elements using the quick window selection 
method. 
1. Verify that the elems selector is active. 

2. Move the mouse handle into the graphics area. 

3. Press and hold the SHIFT key + left mouse button and move the mouse to draw a 
rectangular window around a few elements, and then release the SHIFT key and left 
mouse button. 

All the element handles inside the rectangular window are selected.  

4. Unselect elements by pressing and holding the SHIFT key + right mouse button and 
moving the mouse to create a window around the selected elements. 
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5. Press the SHIFT key and quick-click the left mouse button.  

A pop-up window appears, which contains four icons as shown in the following image. 

  
Quick window pop-up menu 

6. Select the inside polygon shape.   

7. Press and hold the SHIFT key + left mouse button and move the mouse around a few 
unselected elements, and then release the SHIFT key and mouse button. 

This draws a polygon window rather than a rectangular window. All element handles 
inside this window are selected.  

Step 5:  Select and unselect elements by using the extended entity selection 
menu. 
1. Click the elems selector and select reverse. (Select elems >> reverse.) 

The selection of elements is reversed; the elements that were selected are now 
unselected and the elements that were not selected are now selected. 

The menu that appears contains a list of functions for selecting elements. Once you 
select a function from the menu, the menu disappears. If you do not want to select a 
function, move the mouse handle out of the menu.  

 
Extended entity selection menu 

2. Select elems >> by adjacent.  
Elements adjacent to the selected elements are now selected. 

Step 6:  Shade the elements, reset the selection, and select a few adjacent 
elements.  

1. On the Visualization toolbar, click the Shaded Elements & Mesh Lines icon, . 

2. The elements are displayed in shaded mode, rather than wireframe mode. 

3. In the translate panel, click the reset icon ( ) to clear the elements selection. 

4. With the elems selector active, select a few elements that are adjacent to each other.  
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Step 7:  Specify a direction vector (N1 and N2 only) along which to translate 
the selected elements. 

Click the direction selector switch ( , ).  
Direction selector along with the node selectors to define the direction vector 

The menu shown in the following image appears. It contains a list of vector and plane 
options for defining the direction in which to translate the selected elements.   

  
Direction selector pop-up menu 

3. Select N1, N2, N3 from the pop-up menu.  

N1 now has a cyan border indicating it is the active selector. 

The selected elements are displayed in gray because the elems entity selector is not 
active. 

4. In the graphics area, select any node for N1. 

The selected node is highlighted in green. The active selector advances to N2.  

5. Select a node near N1 for N2.  

The selected node is highlighted in blue. The active selector advances to N3. Do not 
select a node for N3.  

Note: Selecting the two nodes, N1 and N2, defines a vector for the direction of 
translation.  This vector goes from N1 towards N2.  Selecting a third node, N3, 
defines a plane.  The direction of translation is the positive direction of the vector 
normal to the plane.  The positive direction is determined by the right-hand rule. 

Step 8: Specify a distance to translate the selected elements and then 
translate them. 

1. Click the toggle ( ) to change magnitude = to magnitude = N2-N1.  

2. Click translate +. 

The selected elements translate in the direction from N1 to N2 by N2-N1 units. 

3. Notice the thick, black border around the translate button. It indicates this is a rapid 
menu button; you can click the middle mouse button rather than click translate +. 

4. Click the middle mouse button. 

The selected elements are translated again by N2-N1 units. 

5. Click translate - twice. 
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The selected elements are translated in the negative N1-N2 vector direction and are now 
in their original position. 

Step 9:  Measure the distance between two nodes. 
1. Press the F4 function key to interrupt, but not exit, the translate panel and go to the 

distance panel on the Geom page. 

The element and node you selected in the translate panel are currently not visible. 
However, they are still selected. They will be visible again when you return to the 
translate panel. 

2. Verify you are in the two nodes sub-panel. 

Notice N1 is the active selector.  

3. Select any node for N1. 

The entity selector advances to N2.  

4. Select a node near N1 for N2. 

Notice the distance = field value reflects the absolute distance between N1 and N2.   

5. Click in the distance = field to highlight the value.  

6. Press CTRL+C to copy the value. 

7. Click return to return to the translate panel. 

8. Notice the elements and nodes you selected in the translate panel before you went to 
the distance panel are once again visible.  

Step 10:  Specify a distance to translate the selected elements and then 
translate them. 
1. Toggle from magnitude = N1-N2 to magnitude =. 

2. Click in the magnitude = field to highlight its value. 

3. Press CTRL+V to paste the distance = value copied from the distance panel. 

4. Click translate +. 

The selected elements translate in the direction from N1 to N2 by the number of units 
specified for magnitude =. 

5. Click translate – once. 

The selected elements are translated in the negative N1-N2 vector direction and are now 
in their original position. 

Step 11:  Calculate 5.5 * 10.5 and specify the resulting value for magnitude =. 
1. Double-click magnitude =. 

2. Click 5 . 5 (in that order) and then click enter. 
3. Click 10 . 5 (in that order). 
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4. Click X. 

The calculated value in the calculator window is 5.775 e+01. 

5. Click exit. 
The calculator closes and 57.75 appears in the magnitude = field. 

You can type a value in the magnitude = field by clicking in the field once to highlight 
the current value. Then type a new value. 

Step 12:  Specify a new vector and translate the elements again. 

1. Click the reset icon, , for the direction selector. ( ) 
2. Notice N1 is the active selector.  

3. Select three nodes for N1, N2, N3 to define a plane. 

4. Click translate + or press the middle mouse button. 

The elements are translated 57.75 units in the positive direction normal to the defined 
plane. 

5. Click return to return to the main menu. 

Step 13 (Optional):  Save your work. 
With all of the exercise complete, you can save the model if desired. 
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Section 4: Organizing a Model 
Organizing model data can be beneficial when creating a valid solver input file. Basic tasks 
used to organize model data such as placing elements and loads into groups (collectors), 
organizing collectors into assemblies, renaming, deleting, reordering, and renumbering are 
discussed in this section.   

In this section, you will learn how to: 

• Create geometry and organize it into components.  

• Organize elements into the components. 

• Rename components. 

• Identify and delete empty components. 

• Delete all the geometry lines. 

• Reorder the components in a specific order. 

• Renumber all the components, starting with ID 1 and incrementing by 1.  

• Create an assembly. 

• Organize the constraints. 
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Model organization is at the heart of a quality Finite Element Analysis.  The model can 
be organized in a multitude of different ways as desired by the user, but below are the 
basics for model organization. 

 

Collectors 
The basis for model organization is the collector.  HyperMesh has 10 different types of 
collectors; 

Component – Contains Elements and Geometry 

Multibody – Contains Ellipsoids, Mbjoints, Mbplanes and Sensors. 

Assembly – Contains Components, Multibodies and Assemblies. 

Load – Contains Loads and Constraints. 

Property* – Used to define the properties assigned to elements or Component 
Collectors 

Material* - Used to define the material values Property Collectors 

System – Contains user defined systems. 

Vector – Contains vectors. 

Beam Section – Contains beam sections. 

*NOTE: Property and Material collectors do not “contain” any entities and are used to 
define material and physical properties in the model.  They are called collectors for 
uniformity. 

 

Collectors can be created in a number of ways. 

• Model Browser: 
Right Clicking in the Model Browser opens a menu from which the selection of 
Create allows for creation of any type of collector. 

 

Right clicking in the Model Browser will also 
allow you to edit, rename, change ID, 
change color and delete collectors as well. 
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• Pull down Menus 
Selecting the Collectors Pull-Down and then selecting Create will provide the 
ability to create any of the non property collectors. 

 
Material and Property Collectors can be created in a similar manner using the 
Material and Property Pull-Downs. 

   

 
 
 
 
 
 
 
 
 

• Icon Toolbars 
The Icons can be used to create collectors as well. 
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Current Collector   -  The Current Collector determines what collector new entities are    
placed in.  The Current Collector can be determined in two ways. 
 

• In the Model Browser the Current collector will be in BOLD   

 Note the mid2 collector is in a bold font and thus is the 
Current collector. 

Right clicking on 
a collector will 
open a menu that 
will allow it to be 
made current. 
 
 
 
 
 

 
 
 

• On the message bar at the right of the screen the Current Collector is shown 

  
This can be clicked to open a window where the Current Collector can be changed 

  
 
Organize – Organize is a tool that can be used to move entities to different collectors.  It 
can be accessed on the Tool page and will open the panel shown below. 
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Exercise: Reorganizing a Bumper Model 

Step 1:  Retrieve the model file, bumper.hm. 

 

Step 2:  Create a component named geometry to hold the model’s geometry.  
1. Access the component collector panel in one of the following ways: 

• From the Pull-down  menu, choose Collectors then Create and select 
Components. 

• On the Collectors toolbar, click component collector ( ). 

2. Go to the create sub-panel. 

3. For comp name=, enter geometry. 

4. Click color  and choose yellow. 

5. Leave the card image= field blank. 

6. Click create to create the component collector, geometry. 

Left-click once anywhere in the HyperMesh window (except on a button) to dismiss the 
message in the header bar. 

The component called geometry now appears in the status bar. It is now the current 
component. Any geometry or elements that are created will be organized into this 
component.  

7. Toggle Property Type to No Property 

8. Click return to return to the main menu. 
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Step 3:  Create two geometry lines and organize them into different 
components.  
1. Access the lines panel in one of the following ways: 

• From the Pull-down menu, choose Geometry, select Create, and click Lines. 

• From the main menu, choose the Geom page, and click lines. 

2. Go to the from nodes sub-panel. 

3. With the node list selector active, select two nodes, opposite and diagonal to each 
other, on the same element as indicated in the following image.  

  
4. Click create to create the line. 

5. Notice the line is yellow, the same color assigned to the component, geometry. This is 
because the line is organized into the current component, geometry. 

6. On the status bar, located at the bottom of the screen, click geometry. 

7. From the list of components in the model, click rigid.  

8. The status bar now shows the current component as rigid. 

9. With the node list selector active, select two nodes, opposite and diagonal to each other 
on another element.  

10. Click create to create the line. 

11. Notice the line is dark pink, the same color assigned to the component, rigid. This is 
because the line is organized into the current component, rigid. 

12. Click return to return to the main menu. 

Step 4:  Move all the model’s geometry surfaces into the component, 
geometry. 
1. Access the Organize panel in one of the following ways: 
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• From the Pull-down menu, select Geometry or Mesh then choose 
Organize>surfaces  

• From the Tool page, access the organize panel 

2. Go to the collectors sub-panel. 

3. Switch the entity selector to surfs. 

4. Select surfs >> all. 
Displayed surfaces are highlighted in white indicating they are selected. All other 
surfaces that are not displayed are still selected because you selected surfs >> all. 

5. Click dest = and select the component, geometry, from the list of components in the 
model.  

6. Click move to move the selected surfaces into the component, geometry. 

Step 5:  Move all the model’s shell elements (quads and trias) into the 
component, center. 
You should still be in the organize panel. 

1. Switch the entity selector to elems. 

2. Select elems >> by collector. 
A list of the model’s components appears. 

3. Select the components, mid1, mid2, and end. 

Select a component by left-clicking its name, color, or check box.  A component is 
selected when it has a check in its check box. To unselect a component, right-click it. 

4. Click select to complete the selection of components. 

5. Set dest = to the component, center. 
6. Click move to move the elements in the selected components to the component, center. 

All of the shell elements should now be a cyan blue, the same color assigned to the 
component, center. 

7. Click return to return to the main menu. 

Step 6:  Rename the component, center, to shells. 
1. Access the Rename panel in one of the following ways: 

• From the Pull-down menu, select Collectors then choose Rename 

• From the Tool page, enter the rename panel. 

2. Go to the individually sub-panel. 

3. Verify the entity type is set to comps.  

4. Click original name = and select the component, center, from the list of the model’s 
components. 
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5. Click once in the new name = field to highlight its text. 

6. Type shells.  

7. Click rename to rename the component. 

8. Click return to return to the main menu. 

Step 7:  Identify and delete all of the empty components. 
1. Access the Delete panel in one of the following ways: 

• From the Pull-down menu, select Collectors then choose Delete>components 

• From the Tool page, enter the delete panel. 

2. Switch the selector to comps. 

3. Click preview empty. 

The message bar displays the message: "3 entities are empty." 

These are the mid1, mid2, and end components that no longer have elements in them. 

4. Click the entity selector, comps, once to see a list of the identified empty components. 

A complete list of the model’s components appears. The empty components are 
indicated with an activated check box. 

5. Click return to return to the delete panel. 

6. Click delete entity. 

The message bar displays the message, "Deleted 3 comps." 

Step 8:  Delete all the geometry lines in the model. 
You should still be in the delete panel.   

1. Switch the entity selector to lines. 

2. Select lines >> all. 
3. Click delete entity. 

The two lines you created earlier are deleted. 

4. Click return to return to the main menu. 

Step 9:  Move the component, geometry, to the front in the components list. 
1. Access the reorder panel in one of the following ways: 

• From the Collectors menu, select Reorder and choose Components. 

• From the Tool page, go to the reorder panel. 

2. Click the comps selector to see a list of the model’s components. 

3. On the right side of the panel, click the switch and select name(id). (Switch from name 
to name(id).) 
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4. Notice the IDs of the components. The ID for shells is one, the ID for rigid is five, and 
the ID for geometry is six. 

5. Select the component, geometry. 

6. Click select to complete the selection. 

7. Activate the option move to: front. 
8. Click reorder to apply the reorder function to the component, geometry. 

9. The message bar displays the message, "The selected collectors have been moved." 

10. Click the comps selector once to review the reordered list of components. 

11. Notice the component, geometry, is at the top of the list. However, it still has the same 
ID, six. 

12. Click return to return to the main menu. 

Step 10:  Renumber the components to be the same as their position in the 
list. 
1. Access the renumber panel in one of the following ways: 

• From the Collectors menu, select Renumber and choose Components. 

• From the Tool page, go to the renumber panel. 

2. Go to the single sub-panel. 

3. Switch the entity selector to comps. 

4. Click the comps selector to see a list of the model’s components. 

5. On the panel’s right side, select comps >> all. 
6. Click select to complete the selection of components. 

7. Verify start with = is set to 1. 

8. Verify increment by = is set to 1. 

9. Verify offset = is set to 0. 

10. Click renumber to renumber the components. 

11. Click the comps selector to review the model’s component list. 

12. Notice the components are numbered according to their position in the list. 

13. Click return to return to the main menu. 

Having components with IDs that do not reflect their position in the model’s list of 
components will not result in errors. However, having components with IDs that do 
reflect their position in the model’s list of components can be helpful for organizational 
purposes. 

Step 11:  Create an assembly containing the components, shells and rigid. 
1. Access the assemblies panel in one of the following ways: 
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• From the Collectors menu, select Create and choose Assemblies. 

• From the Tool page, go to the assemblies panel. 

2. Go to the create sub-panel. 

3. For name =, enter elements. 

4. Leave the card image = field blank. 

5. Click the comps selector to see a list of the model’s components. 

6. Select the components shells and rigid. 

7. Click select to complete the selection of components. 

8. Click create to create the assembly. 

9. Click return to return to the main menu. 

Step 12:  Create a load collector named constraints. 
1. Access the Load collector panel in one of the following ways: 

• From the Collectors menu, choose Create and select Load Collectors Icon 

• On the Collectors toolbar, click Load Collectors Panel 
2. Go to the create sub-panel. 

3. For name =, enter constraints. 

4. Click color and choose red. 

5. Leave the card image = field blank. 

6. Click create to create the load collector. 

The message bar displays the message: "The loadcol was created." 

7. Left-click anywhere in the HyperMesh window (except on a button) to dismiss the 
message in the message bar. 

8. Notice that loadcol constraints now appears in the status bar. The current load 
collector is constraints. Any loads that are created will be organized into this load 
collector.  

9. Click return to return to the main menu. 

Step 13:  Move the model’s one constraint into the load collector, constraints. 
The existing load collector, loads, contains several forces and one constraint. The organize 
panel is used to move the one constraint in the load collector, constraints. 

1. From the Tool page, enter the organize panel. 

2. Go to the collectors sub-panel. 

3. Switch the entity selector to loads. 

4. Select loads >> by config. 
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5. Click config = and select const. 
6. In the center of the panel, toggle from displayed to all. 
7. Click select entities. 

8. Verify that dest = is set to the load collector, constraints. 

9. Click move to move the selected (constraints) into the load collector, constraints. 

Step 14:  Open the model browser. 
• Click the Model tab in the tab area if the tab area is open. Or go to the View menu 

and select Model Browser.   

 

Step 15:  Create a component from the model browser. 
1. Right-click in the white blank area below the list of components, materials, load 

collectors, and system collectors in the model browser.  
2. From the pop-up menu, select Create > Component.  
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3. Click the color icon and chose the component’s color as pink. 

4. Click Create to create the component.  

 
The component named component1 is appended to the list.  

5. In the model browser, click the + button beside the Components entity to see that 
Component1 is bolded in the list to indicate it is the current component. 

Step 16:  Review the existing assembly elements from the model browser. 
1. Left-click the + button next to Assembly Hierarchy then click the + button next to 

elements to expand its tree. Notice that it contains two components, rigid and shells.  
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Step 17:  Add the components, geometry and component1, to the assembly, 
assem_mid, using the model browser. 
1. Left-click the component name, geometry, to select it. 

2. Press the CTRL key and left-click the component name, component1. 

Press the CTRL key and left-click a selected item to deselect it.   

3. Left-click any one of the selected components and drag the mouse pointer over the 
assembly, assem_mid. When assem_mid is highlighted, release the mouse button.  

The selected components are added to the assembly, assem_mid. 

Use the SHIFT key and left mouse button to select multiple items in the Model Browser 
list at one time. Left-click the first item in the list. Then press the SHIFT key and left-click 
the last item in the list. 

Step 18:  Rename the assembly, assem_mid to assem_geom, from the model 
browser. 
1. Right-click assem_mid and select Rename. 

Assem_mid is highlighted and ready for editing. 

2. Type assem_geom and press ENTER. 

Step 19:  Delete component1 from the model browser. 
1. Right-click component1 and select Delete. 

2. Confirm that you wish to delete the component by clicking yes in the delete confirm 
dialog. 

Component1 is deleted. 

Notice that in the list, there is no bolded component name. This indicates there is no 
current component specified. 

Step 20:  Set the current component from the model browser. 
1. Right-click shells and select Make Current. 

The component name is bolded.  

2. Notice that the header bar specifies that that current component is shells. 
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Section 5: Controlling the Display 
When performing finite element modeling and analysis setup, it is important to be able to 
view the model from different vantage points and control the visibility of entities. You may 
need to rotate the model to understand the shape, zoom in to view details more closely, or 
hide specific parts of the model so other parts can be seen. Sometimes a shaded 
visualization is best, while other times a wireframe visualization is needed to work on details 
inside the model. 

HyperMesh has many functions to help you control the view, visibility, and visualization of 
entities.  This exercise introduces you to these functions.  

In this section, you will learn how to: 

• Control the points of view, mouse, and toolbar.  

• Control the visibility of entities using the display panel, mask panel, and tools on the 
Utility menu. 

• Control how entities look by using the toolbar, and the model browser. 

• Rename components. 

• Identify and delete empty components. 

• Delete all the geometry lines. 
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View control is accomplished through the use of the Toolbar Icons and the mouse. 

• Tool Bar Icons 
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CONT. 

• Mouse Control – The preferred method for Display Control is the use of the 
Mouse Buttons. 

       With the CTRL key held on the keyboard the mouse provides total control  
       over rotation, zoom and pan. 
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Model Visualization 
• Elements 

 
• Geometry 
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Mask 
The masking tools allow the user to show and hide select entities that might interfere with 
desired visualization.  The icons can be found on the Display toolbar and are used as 
follows;  

 
MASK – Allows for the selection of entities to hide 
REVERSE – Flips the display of masked and unmasked entities. 

UNMASK ADJACENT – Unmasks entities immediately adjacent to those shown. 

UNMASK ALL – Unmasks all entities. 

MASK NOT SHOWN – Masks all the entities that are outside the viewing area. 

SPHERICAL CLIPPING – Allows for a sphere of visualization to be defined. 

FIND – Allows for elements to be found (typically by ID) 

DISPLAY NUMBERS – Utility to turn on and off the display of entity numbers. 

DISPLAY ELEMENT HANDLES – Turns on and off element handles. 

DISPLAY LOAD HANDLES – Turns on and off load handles. 

DISPLAY FIXED POINTS – Turns on and off fixed points.  

 
 
Model Browser 
The model browser is a powerful tool for controlling the visualization of the model.  In the 
model browser the user can; 

• Turn on and off the display of the geometry  and elements  of collectors 

 

 

• Control the color of the collector 
(Right Click) 

• Control the visualization of the collector. 
(Right Click) 
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Exercise: Viewing a Model 

Step 1:  Retrieve the HyperMesh model file, bumper.hm. 

Step 2:  Manipulate the model view using the mouse controls. 
The CTRL + mouse keys are used to rotate the model, change the center of rotation, zoom, 
fit, and pan. 

1. Move the mouse pointer into the graphics area. 

2. Press the CTRL key + left mouse button and move the mouse around. 

The model rotates with the movement of the mouse.  

A small white square appears in the middle of the graphics area, indicating the center of 
the rotation.  

Release the left mouse button and press it again to rotate the model in a different 
direction. 

3. Press the CTRL key and quick-click the left mouse button anywhere on the model.  

The center of rotation square appears near where you clicked.  

HyperMesh searches for one of the following conditions in the listed order and relocates 
the center of rotation at or near the first condition identified (if none of the conditions are 
met, the center of rotation is relocated to the center of the screen): 

• A nearby node or surface vertex 

• A nearby surface edge to project onto 

• A nearby geometry surface or shaded element 

4. Press the CTRL key + left mouse button to rotate the model and view the change in 
rotation behavior. 

5. Press the CTRL key and quick-click the left mouse button anywhere in the graphics 
area, except for on the model. 

The center of rotation square is relocated to the center of the screen. 

6. Press the CTRL key + left mouse button to rotate the model and observe the change in 
rotation behavior. 

7. Press the CTRL key + middle mouse button, move the mouse around, and then release 
the mouse button.  

A white line is drawn along the path of the mouse movement. When the mouse button is 
released, HyperMesh zooms in on the portion of the model where the line was drawn.  

You can also simply draw a line to zoom in on a portion of the model.  

8. Press the CTRL key + quick-click the middle mouse button.  

The model is fitted to the graphics area. 

9. Press the CTRL key and spin the mouse wheel. 
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The model zooms in or out depending on which direction you spin the mouse wheel. 

10. Move the mouse pointer to a different location in the graphics area and repeat #9. 

Notice the model zooms in or out from where the mouse handle is located. 

11. Press the CTRL key + quick-click the middle mouse button to fit the model to the 
graphics area. 

12. Press the CTRL key + right mouse button and move the mouse around.  

The model is panned (translated) according to the mouse movement. 

Step 3:  Manipulate the view of the model using the rotate functions on the 
toolbar. 

1. On the View Controls toolbar, left-click dynamic rotate, .  

The status bar displays the message, "Move the mouse into the graphics region." 

2. Move the mouse pointer into the graphics area. 

The center of rotation square appears. 

3. Press and hold the left mouse button, and then move the mouse around. 

The model rotates with the movement of the mouse, similar to the way the model rotates 
when you press the CTRL key + left mouse button and move the mouse. 

4. Click the middle mouse button on the model.  

The center of rotation square appears near where you clicked.  

5. Move the mouse pointer out of the graphics area or right-click to exit the rotation mode. 

6. On the View Controls toolbar, right-click dynamic rotate, , and move the mouse 
pointer into the graphics area. 

Again, the center of rotation square appears. You can click the middle mouse button on 
the model to change the center of rotation. 

7. Press the right mouse button near the center of rotation square. 

The model rotates continuously in the direction of your mouse pointer, relative to the 
center of rotation. 

8. With the right mouse button still pressed, move the mouse around slowly. 

The direction and speed of the rotating model changes. The farther the mouse pointer is 
from the center of rotation, the quicker the model rotates.  

You can release the right mouse button, and then press it again to rotate the model in a 
different direction. 

9. Middle mouse click anywhere in the graphics area, except on the model. 

The center of rotation square is relocated to the screen’s center. 

10. Move the mouse pointer out of the graphics area or left-click to exit the rotation mode. 
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Step 4:  Manipulate the view of the model by using the zoom in and out 
functions on the toolbar. 

1. On the View Controls toolbar, left-click circle / dynamic zoom, . 

The status bar displays the message, "Circle the data to be zoomed in on." 

2. Move the mouse pointer into the graphics area. 

3. Press the left mouse button, move the mouse around, and then release the left mouse 
button. 

A white line is drawn along the path of the mouse movement. When the mouse button is 
released, HyperMesh zooms in on the portion of the model where the line was drawn.  

You can also simply draw a linear line to zoom in on a portion of the model.  

This function is similar to pressing the CTRL key + middle mouse button to zoom into a 
portion of the model. 

4. On the Standard Views toolbar, click fit, .  

The model is fitted to the graphics area. 

5. On the View Controls toolbar, left-click zoom in / out, .  

The model is zoomed in by the factor specified in the options panel. 

6. On the View Controls toolbar, right-click zoom in / out, .  

The model is zoomed out by the same factor. 

7. From the Preferences menu select Meshing Options or Geometry Options. 

8. Go to the geometry or mesh sub-panel. 

9. For zoom factor =, specify 4. 

10. Click return to return to the main menu. 

11. On the View Controls toolbar, left-click zoom in / out, .  

The model is zoomed in by the larger, specified factor.  

12. On the View Controls toolbar, right-click circle / dynamic zoom, .  

The status bar displays the message "Move the mouse into the graphics region." 

13. Move the mouse pointer into the graphics area, press the right mouse button, and then 
move the mouse pointer up and down. 

The model is zoomed in and out according to how far you move the mouse up or down. 

14. Move the mouse pointer out of the graphics area or left-click to exit the dynamic zoom 
mode. 
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Step 5:  Manipulate the model view using the arrows and view panel on the 
toolbar. 

1. On the View Controls toolbar, right-click or left-click any of the rotate icons ( , 

, ). 

The model rotates in the direction of the arrow by the rotation angle specified in the 
options panel. 

2. On the Standard Views toolbar, left-click view, . 

The view panel pops-up. 

3. Click top to view the model along the Z-axis. 

4. Exit the view panel by moving the mouse pointer out of the pop-up window. 

5. From the Preferences menu select Meshing Options or Geometry Options. 

6. For rotate angle =, specify a value of 90. 

7. Click return to return to the main menu. 

8. Click either rotate icons ( , , ). 

Notice the model rotates by the new specified rotation angle, 90. 

9. Change the view of the model to any view. 

10. Use CTRL + left mouse button, or the rotate icons on the toolbar to rotate the model. 

11. Use CTRL + middle mouse button, or the zoom icons on the toolbar to zoom into or out 
on the model. 

12. On the Standard Views toolbar, left-click view, . 

13. For save1 = enter my view. 

14. Click save1 = to save the view. 

15. Click top to display a different view of the model. 

16. Click restore1 to retrieve the view stored for save1 =. 

Both the view angle of the model and level of zoom are saved. 

17. Move the cursor away from the view panel to exit. 

Step 6:  Control the display of components using the toolbar.  

1. On the Visualization toolbar, click Shaded Elements & Mesh Lines, .  

2. Notice the shell elements now have been shaded.  
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3. Right-click Shaded Elements & Mesh Lines, , and switch to Shaded Elements & 

Feature Lines, . 

4. Notice now the elements shading does not show any mesh lines. Only feature lines are 
displayed. 

5. Right-click Shaded Elements & Feature Lines, , to access Shaded Elements, 

. 

6. Notice now the feature lines are also removed from the display. 

7. Click Wireframe Elements (Skin Only), , to return to the wireframe shading mode.  

Step 7:  Control the display of components using the Visual Attributes panel. 

1. On the Visualization toolbar, click Geom/Mesh Styles, . 

2. Click hidden line, . 

3. Select a component from the list of components.  

The component’s elements are displayed in hidden line (shaded) mode.  

4. Click all to select all components and set their display mode to hidden line (shaded) 
mode.  

5. Experiment with the other display modes.  

Icon Display Mode 

 
Wireframe – Element edges are displayed with lines. 

 
Hidden Line  – The element is displayed as a filled polygon. 

 
Hidden Line with Mesh Lines – The element is displayed as a filled polygon 
with the feature  edges drawn in mesh line color.  

 
Hidden Line with Feature Lines – The element as a filled polygon with the 
feature edges in mesh line color. 

 
Transparent  – The element is displayed as  a filled transparent polygon. 

6. Click return to return to the main menu. 
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Step 8:  Control the visibility of various entity categories using the model 
browser.  
1. In the tab area, activate the Model tab. 

2. Right-click anywhere in the white space of the browser list and pick Expand All from the 
context menu. 

This will open all of the branches of the model browser. 

3. At the top of the model browser, click Display none, . 

The display of all entities in the model is turned off. 

4. Click Display all, . 

All entities in the model are now displayed. 

5. In the browser list, left-click Component (5) to select it. 

6. Click Display none, . 

The display of component collectors is turned off, but all other entities remain displayed. 

Display all, Display none, and Display reverse act globally (on all entities) if nothing in 
the browser list is selected.  If a folder is selected (highlighted), the action will be 
performed only on the entities within that folder.  If an individual entity is selected, the 
action will apply only to that entity. 

7. Left-click in the white space of the browser list. 

This deselects all entities in the browser list. 

8. Click Display reverse, . 

The display is reversed.  Only the components are now shown instead of everything but 
components. 

9. Click Component view, . 

Only the component collectors are shown in the browser list. 

10. Right-click the elements and geometry filter to change it from Elements + Geometry, 
, to Elements, . 

Display all, Display none, and Display reverse will no longer affect the display of 
geometry in the components. 

11. Click Display none, . 

Only geometry is now left in the display. 

12. Switch the elements and geometry filter back to Elements + Geometry, . 

13. Click Display reverse, . 

Only elements are now displayed. 
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Step 9:  Control the visibility of individual components using the model 
browser. 
1. Click elements, , next to the mid2, end, and rigid components.  

2. Only the components center and mid1 have their elements displayed now. 

3. Press F on the keyboard. 

4. The displayed components are fitted to the graphics area. 

5. Click geometry, , next to the components mid2 and end. 

6. Fit the displayed components to the graphics area (F). 

 The geometry in the components, mid2 and end, and the elements in the components, 
center and mid1, are displayed. 

A component collector has two ‘compartments’: one for elements and the other for 
geometry.  The display for elements and geometry in a component can be controlled 
separately. 

Step 10:  Control the display of entities using the mask panel.  
1. Access the mask panel in one of the following ways: 

• On the display toolbar, click Mask,  

• From the main menu, click the Tool page, then select the mask panel 

2. Go to the mask sub-panel. 

3. With the elems selector active, select elems >> by collector. 
4. Select the component, mid1. 

5. Click select to complete the selection of components. 

6. From the graphics area, manually select a few elements in the center (blue) component. 

7. Click mask to mask the elements. 

The elements in the mid1 component and the elements you selected from the graphics 
area are no longer displayed. 

8. In the model browser, notice that the elements ( ) for the components center and mid1 
are still displayed.  Their display icons indicate that they are activated even though some 
or all of the elements in these components are masked (hidden).  

9. In the mask panel, click unmask all, or on the display toolbar click unmask all, . 

All the elements in the components, center and mid1, are visible again. 

Notice the elements in the other components are not displayed. This is because these 
components are not active in the Display panel. 

10. Click return to exit to the main menu. 
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Step 11:  Control the display of entities using the find panel.  
1. Access the find panel in one of the following ways: 

• On the display toolbar, click find, . 

• From the main menu, click the Tool page, then select the find panel. 

2. Go to the find entities sub-panel. 

3. Select elems >> by collector, and select the component, end, from the components 
list. 

4. Click select to complete the selection of components. 

5. Click find to find the elements. 

The elements in the component, end, are displayed. 

5. In the model browser, notice that the elements for the component, end, are now shown 
as active ( ). This is because the collector containing the entities that are to be 
displayed (found) must be active.  

6. Go to the find attached sub-panel. 

7. For attached to:, select elems >> displayed. 

8. Click find to find the elements. 

Some of the elements in the components, mid2 and rigid, are now displayed.  These 
elements are immediately adjacent and connected to the selected elements. 

Again, notice that the elements for these components are now shown as active ( ).  
The components were made active so that the elements could be displayed. 

9. Click return to return to the main menu. 

10. On the display toolbar, click Unmask All ( ). 

All of the model’s elements are now displayed. This is because the find panel finds the 
entities it is supposed to find, activates (displays) the corresponding collectors, and 
masks the other entities in the collectors it activated. In this case, the last find command 
displayed on the components, mid2 and rigid, in the model browser. 

Step 12:  Change the display of entities using the Mask By Config tab. 
1. In the model browser, click in the white space of the browser list to make sure nothing 

is selected. 

2. Click Display none ( ). 

3. Click Display all ( ). 

Performing these two steps makes sure that everything is displayed in the model. 

4. Click to the Mask By Config tab. 

5. Click the 1 in the Isolate column for Components. 
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Only the components in the model (elements, geometry, and connectors) are displayed.  
Everything else is now masked. 

6. Expand the Components branch to expose connectors, elements, and geometry. 

7. Click the – in the Hide column for Elements. 

The elements in the model are now masked, leaving only surfaces shown. 

8. Expand the LoadCollectors branch to expose loads and equations. 

9. Expand the Loads branch to expose constraints, forces, moments, etc. 

10. Click the + in the Show column for Constraints. 

Constraints are added to the display of the surfaces. 

11. Expand the Elements branch to expose 0D/rigids, springs/gaps, 1D, 2D, and 3D. 

12. Click the 1 in the Isolate column for 0D/Rigids. 

Rigid elements are added to the display, while the surfaces are now masked.   The 
constraints remain displayed.  This is because using isolate below the top level of the list 
will not mask anything outside of the top level that entity belongs to.  Rigids belong to 
components at the top level, so no entities in the other top levels are masked. 

13. Click the 1 in the Isolate column for Components. 

All of the entities in the components are shown again, while the constraints are masked.   
This is because using isolate at the top level of the list (components, groups, 
loadcollectors, morphing, multibodies, and systemcollectors) will mask everything 
outside of the entity type being isolated. 

Step 13:  Change the color of components using the model browser. 
1. Click the Model tab to go to the model browser. 

2. Right-click color ( ) next to mid2. 

3. From the color pop-up, select a different color. 

 
4. Observe the change in color of the elements in mid2. 

Step 14:  (Optional) Save your work. 
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Chapter 2 

Geometry Clean-up 
Section 1: Importing and Repairing CAD 
HyperMesh is capable of importing geometry from many CAD sources.  Most of the popular 
CAD packages are read directly and for those that are not HyperMesh supports the popular 
intermediate languages as well.  While the importation of data generally occurs with little 
error, there are issues that can occur, and as such HyperMesh, offers a wide variety of tools 
to remedy these geometric issues. 

 

The benefits of importing and repairing CAD are:  

• Correct any errors in the geometry from import 

• Create the simplified part needed for the analysis 

• Mesh a part all at once  

• Ensure proper connectivity of mesh 

• Obtain a desirable mesh pattern & quality 

In this section, you will: 

• Delete untrimmed surfaces 

• Close missing surfaces 

• Set the cleanup tolerance 

• Equivalence free edges 

• Delete duplicate surfaces 
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Geometry Import 

Importing geometry occurs in the import tab, accessible through the Import Icon .   Using 
this tab the user can import data from popular CAD packages such as 

• Unigraphics (NX2,NX3,NX4,NX5)  
o Supports import of .prt files 
o Provides a UG part browser 
o Requires an installation of UG to be 

accessible, either locally or on a 
network 

 
• CATIA (V4,V5) 

o Supports import of .model (V4) files 
o Additional license from Altair is 

required of .catpart (V5) file import. 
 

• Pro/Engineer (Wildfire 2.0 & 3.0) 
o Supports import of .prt and .asm 

files. 
 
Additionally HyperMesh supports the import of the 
following intermediate translational languages: 

• IGES (.igs & .iges) 
• STEP (.stp) 

 
Topology Repair 
Surface Definition 
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Topology 
Topology deals with the connection of adjacent surfaces.  Connectivity is critical as 
HyperMesh will create a contiguous mesh over connected faces thus guaranteeing stresses, 
strains and deformations will propagate over the part in a realistic manner.  When importing 
native CAD files, HyperMesh will read surface connectivity directly from the file.  When using 
intermediate languages (IGES or STEP) HyperMesh will use a tolerance calculation to 
determine when two edges should be connected.  While this will work very well, there can 
be issues with connectivity that will need to be fixed before meshing. 
 
HyperMesh allows for easy visualization of surface connectivity through the use of an edge 
color scheme shown below; 

 
 
Topology Visualization 

 Display of topology can be controlled with 
this pulldown found on the icon tool bar. 
 
 
 
 
 
 

• Auto: Surfaces and Edges will be displayed in the component color unless the user 
is in a topological editing function where then surfaces will be colored grey and 
edges will be in their topological color. 

• By Comp: Surfaces and Edges will always be displayed in component colors. 
• By Topo: Surfaces will always be colored grey and edges will always be in their 

topological color. 
• By 2D Topo: Only 2D topology will be displayed in topological color. 
• By 3D Topo: Only 3D topology will be displayed in topological color. 
• Mixed: Similar to By Topo but while the edges will be in topological colors, the 

surfaces will be in their component color and not grey. 
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Topology Visualization cont 

On the toolbar the Topology Options Icon   will open the visualization tab 
 
This tab will allow the user to display or 
hide 2D and 3D topology based on its 
type. 
 
This tab also allows the user to control 
the transparency and change the 
shading colors of mappable solid 
regions. 
 
Other functionality in this tab allows 
visualization control over the following:  

Connector  

Constraints   

Loads  

Morphing  

Systems  

Vectors  
 
 
 

 
Topology Repair 
While HyperMesh will in most cases create proper and connected geometry accurately 
representing the initial CAD geometry, there can be issues with the import.  Common issues 
are: 
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Topology Repair: Tools 
HyperMesh has a supply of tools to repair issues in the geometry.  
The ultimate goal of Topology Repair is to assure that the geometry that is used to create 
the mesh is as close as possible to the design intent of the original CAD data.  To this end, 
these are the tools that HyperMesh provides; 

•  Edge Edit Panel  
o Equivalence (multiple edges at a time) 

o Search surfaces for pairs of free edges and combine into shared 
edges 

o Toggle (1 edge / edge pair at a time) 
o Select an edge; equivalences with other free edges found within a 

user specified tolerance 
o Replace (1 edge pair at a time) 

o Select 2 edges to equivalence together 
o Control which edge to retain and which to move 

• Point Edit Panel 
o Replace (1 edge at a time) 
o Release – Combine pairs of free edges with gaps between them into shared 

edges 
• Defeature Panel 

o Duplicates – Identify and delete duplicate surfaces within a user specified 
tolerance 

• Surfaces Panel  
o Spline / filler – Select lines / surface edges to recreate any missing surfaces 

• Quick Edit Panel 

 
The Quick Edit Panel is a “tool box” of utilities for geometry repair.  Many of the tools 
can be found in other panels and their functionality is exactly the same. The Quick 
Edit panel simply provides a single location for many of the most often used tools.  
These include: 

• Unsplit – Removes / deletes an edge created by splitting a surface in 
HyperMesh. 

• Toggle – Same as edge edit panel; change edge type within tolerance. 
• Filler surf – Select a line on a free surface edge to recreate any missing 

surfaces. 
• Delete surf – Same as delete panel (surfaces only). 
• Replace point – Same as point edit panel; move/retain point. 
• Release point – Same as point edit panel; must be associated with line. 
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Topology Repair: Strategy 
 Understand the size and scale of the model 

o With models that represent everything from full size ships to 
microscopic electronic parts all residing in a graphics area on a 
computer monitor, it is often difficult to understand the overall scope of 
the model.  It is critical to get  an idea of the overall size of the model 
and determine a global element size  that will be applied to the 
eventual mesh. 

 Set a cleanup tolerance based upon the previously determined global 
element size. 

o With the element size established, a cleanup tolerance can now be 
set.  The cleanup tolerance specifies the largest gap size to be closed 
by the topology functions.  This value should never exceed 15-20% of 
the global element size.  Values beyond this limit can introduce 
distortion into the mesh. 

 Use topology display tools to determine what needs to be fixed. 
 Find duplicate surfaces and delete them. 
 Use equivalence to combine as many free edge pairs as possible. 

o Visually verify no surfaces were collapsed with this function. 
 Use toggle to combine and remaining edges. 

o Use replace if more control is needed. 
 Use filler surface to fill in any missing surfaces.
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Exercise: Importing and Repairing CAD Geometry Data 

This exercise uses the model file, clip_repair.hm. 

 

Step 1:  Open and view the model file, clip_repair.hm. 

Step 2:  View the model in topology display toolbar and shaded mode to 
evaluate its integrity. 
1. Observe where the model has incorrect connectivity and missing or duplicate surfaces. 

2. Go to the autocleanup panel. 

Note that the surface edges are now colored according to their topology status. This 

occurs because Geometry Color is set to auto ( ).    

3. Click Wireframe Geometry ( ) and Shaded Geometry & Surface Edges ( ) to 
explore the different display modes.  

The toolbar contains icons that control the display of the surfaces and surface edges. 
Surfaces can be shaded (with or without edges) or displayed in wireframe. Right-click 
the icons to access the drop-down menu for additional options. Place your mouse over 
the cursor to view a description of the button’s functionality. 

4. Click Visualization ( ) and navigate to the Topology tab. 
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Visualization controls the display of the surfaces and surface edges. Surfaces can be 
shaded or wireframe. The check boxes within this menu turn the display of the different 
edge types and fixed points (surface vertices) on or off. 

5. Clear all the check boxes except the Free check box. 

6. Move the mouse cursor off the pop-up menu to close it. 

Only the free edges should be displayed at this point. 

7. Observe the free edges and make note of where they are. 

The free (red) edges show where there is incorrect connectivity or gaps. 

8. Note the locations where there are closed loops of free edges. These are locations that 
probably have missing surfaces. 

 
Free edges indicating surface discontinuities of the clip geometry 

9. Click the Visualization icon, ,  and select only the T-junctions edges check box. 

10. Observe the t-junction edges and make note of where they are. 

The t-junction edges show where there are more than two surfaces sharing an edge, 
which might be incorrect connectivity. For this part, there are yellow edges completely 
surrounding two areas. This indicates that there are probably duplicate surfaces in these 
locations. 

11. Click the Visualization icon, ,  and select all the check boxes. 
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12. Click the Shaded Geometry & Surface Edges icon, . 

The surfaces should now appear solid rather than having only their edges displayed. 

13. Rotate, zoom, and pan to locate any errors in the geometry. 

14. Make note of the areas to be worked on. There is: 

• A surface that overhangs a round corner 

• A missing surface 

  
Surface overhanging an edge and a missing surface 

An edge that has apparently been collapsed 
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Area of collapsed edge 

15. Click Wireframe Geometry ( ) to change back to wireframe. 

Step 3:  Delete the surface that overhangs the round corner. 
1. Enter the Delete panel in one of the following ways: 

• From the Geometry menu, point to Delete and click Surfaces  

• Press F2 

2. In the Graphics area, select the overhanging surface shown in the previous figure. 

3. Click delete entity and click return. 

4. Return to the main menu. 

Step 4:  Create surfaces to fill large gaps in the model. 
1. Access the surfaces panel.  

2. Access the spline/filler sub-panel. 

3. Clear the keep tangency check box. 

The keep tangency option looks at surfaces attached to the selected edges and tries to 
create a surface tangent to them. This helps to form a smooth transition to the 
surrounding surfaces. 

4. Verify the entity type is set to lines.  

5. Verify the auto create (free edges) check box is selected. 
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The auto create option simplifies the selection of the lines bounding the missing surface. 
Once a line is selected, HyperMesh automatically selects the remaining free edges that 
form a closed loop, and then create the filler surface. 

6. Zoom into the area indicated in the following image. 
 

 
Area of missing surfaces 

7. Pick one of the red lines bounding one of the gaps (missing surfaces). 

HyperMesh automatically creates a filler surface to close the hole.  

8. Repeat #7 to create a filler surface in the other gap.  

9. Click return. 

Step 5:  Set the global geometry cleanup tolerance to .01. 
1. Press O to go to the options panel. 

2. Go to the geometry sub-panel. 

3. In the cleanup tol = field, type 0.01 to stitch the surfaces with a gap less than 0.01. 

4. Click return to go to the main menu. 
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Step 6:  Combine multiple free edge pairs at one time with the equivalence 
tool. 
1. Enter the Edge Edit panel in one of the following ways: 

• From the Pull-down menu, select Geometry, then Edit, then edges 

• From the main menu, select Geom Page, then choose Edge Edit 
2. Go to the equivalence sub-panel. 

3. Activate the equiv free edges only check box. 

4. Select surfs >> all. 
5. Verify that the cleanup tol= is set to 0.01, which is the global cleanup tolerance specified 

in the options panel. 

6. Click the green equivalence button to combine any free edge pairs within the specified 
cleanup tolerance.  

Most of the red free edges are combined into green shared edges. The few remaining 
are caused by gaps larger than the cleanup tolerance. 

Step 7:  Combine free edge pairs, one pair at a time, using the toggle. 
1. Go to the toggle sub-panel. 

2. In the cleanup tol = field, type 0.1. 

3. In the Graphics area, click one of the free edges shown in the following image. 

4. Rotate and zoom into the area if needed. When the edge is selected, it will change from 
red to green, indicating that the free edge pair has been equivalenced. 

  
Area where free edges need to be toggled 
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5. Use toggle to equivalence the other edges shown in the image. 

Step 8:  Combine the remaining free edge pair using replace. 
1. Go to the replace sub-panel. 

2. Click user views ( ). 

3. Click restore1 to bring back the saved view. 

4. With the selector under moved edge: active, click the leftmost free edge in the 
Graphics area. 

Verify that the selector under retained edge: is now active.  

5. Select the rightmost red edge. 

6. In the cleanup tol = field, enter 0.1. 

7. Click replace.  

Once the line is selected, HyperMesh posts a message similar to: 
 
"Gap = (.200018). Do you still wish to toggle?" 

8. Click Yes to close the gap. 

  
Edges to retain and move for replacement 

9. Click return to go to the main menu. 
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Step 9:  Find and delete all duplicate surfaces. 
You should still be in the geom cleanup panel. 

1. Access the Defeature panel in one of the following ways: 

• From the Pull-down menu, choose Geometry, then Defeature 

• From the main menu, choose Geom Page, then Defeature 

2. Go to the duplicates sub-panel. 

3. Select  surfaces >> displayed. 

4. In the cleanup tol = field, type 0.01. 

5. Click find. 

The message bar displays the following message, "2 surfaces are duplicated." 

6. Click delete to remove any duplicate surfaces.  

Step 10:  Observe the model again to identify any remaining free edges, or 
missing or duplicate surfaces.  
1. Use the topology display and shaded modes to perform this task.  All of the edges in the 

model should be displayed as green shared edges, indicating that we have a completely 
enclosed thin solid part. 

2. Click return to go to the main menu. 

Step 11 (Optional):  Save your work 
With the cleanup operations completed, save the model. 
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Section 2: Generating a Midsurface 
This exercise uses CAD geometry data for a thin solid clip.  Because of the small thickness 
of the part, it is assumed that it will be modeled for FEA as shell elements. The elements will 
be created on the mid-plane of the part. 

In this section, you will learn how to: 

• Create a midsurface 

• Visualize the midsurface by using shading options and transparency 
 
 



Chapter 2:Geometry Clean-up 

 

68 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

Midsurfacing: Introduction 
Often the most accurate representation of a part is through the use of shell elements.  
These elements best represent parts that are relatively thin compared to their overall 
surface area and typically have a uniform thickness.  Shell elements have no physical 
thickness representation, they are displayed as two dimensional entities whose thickness is 
simply a numerical value assigned to them.  FE Solvers assume the shell element to lie at 
the middle of the thickness.  As that is the case the mesh created on the surfaces needs to 
lie at the mid-plane of the part.  CAD geometry is usually created as either a solid part or a 
series of faces representing a solid part.  Using the midsurface tool in HyperMesh proper 
surfaces can be extracted that lie on the mid-plane of the part and can be meshed 
appropriately. 

  
Midsurfacing: Tools 
 
Midsurface Creation: 

 
• Auto Midsurface – Automatically extracts midsurfaces from surfaces that enclose a 

volume or a solid geometry 
o Can sometimes work if there are missing surfaces 
o The greater number of missing surfaces, the less reliable the result 

• Surface Pair – creates a midsurface between 2 selected surfaces 
 
 
Midsurfacing: Tools cont. 
Midsurface Modification 
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• Quick Edit – Repair a midsurface by correcting where the verticies of the surface 

were placed.  
• Assign Target – An extension to quick edit, and functions in a similar fashion.  
• Replace Edge – Fill in gaps and slivers by combining one surface edge with 

another. 
o same as in the edge edit panel  

• Extend Surface – Extends two surfaces (e.g., ribs) until they intersect.  
• View Thickness – Review of the thickness of a midsurface using white lines 

(probes) extending from each vertex of the surface. 
 
Midsurfacing: Strategy 
 
 Obtain a closed volume of surfaces or solids 
 For complex parts try defeaturing the defining volume 

o This simplifies the part and can produce a better midsurface.  See section 3 
of this chapter for more information about defeature. 

 Generate the midsurface using the auto midsurface 
 View the midsurface and correct any errors using modification tools.
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Exercise: Generating a Midsurface 
The surfaces in the model have no connectivity errors.  This could be because the file was 
imported without errors or because the errors were corrected using HyperMesh.  In this 
case, errors in the topology were repaired in the previous exercise (missing surfaces are re-
created, duplicate surfaces are deleted, gaps are closed, etc.).  You can use either the file 
created from the previous exercise, or open the new, clip_midsurface.hm, file.  Either 
way, the geometry is at the point where you can use the midsurface panel to generate a 
midsurface. 

Step 1:  Retrieve and view the model file. 
This exercise uses the model, clip_midsurface.hm. 

1. On the visualization toolbar, change the visualization to Shaded Geometry & Surface 

Edges ( ).  

2. On the visualization toolbar, set the Geometry Color drop-down menu to Mixed 

( ). 

3. To change the model back to wireframe click wireframe ( ).  

Notice how the surfaces represent a solid part, these visualization techniques will be 
necessary for viewing the newly created midsurface.  

Step 2:  Generate a midsurface from midsurface panel. 
1. Access the misurface panel by doing one of the following: 

• From the Pull-down menu, select Geometry, then Midsurface 

• From the main menu, select the Geom page, then select midsurface 

2. Go to the auto midsurface panel. 

3. Verify that the closed solid option  and the yellow surfs selector are active. 

4. Select one surface from the graphics area.  

5. Click extract to start the midsurface generation. 

The midsurface is created, and the surfaces are organized into a new Middle Surface 
component.  Note that when a midsurface is created, transparency is turned on for all 
the other components in the model except the new Middle Surface component.  The 
next step covers how to control surface transparency.      

Step 3:  Review the part’s midsurface. 
1. From the model browser, turn off the display of geometry in the component named lvl10 

to display only the Middle Surface component. 
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The midsurfaces generated for the solid sections of the model using the solid sub-panel 
are shown in the following image.  

 
Midsurface generated from a volume of surfaces 

2. Turn the geometry for lvl10 component back on from the model browser. 

3. On the visualization toolbar, access the transparency panel ( ). 

4. With the comps selector active, select a line or surface of the lvl10 component in the 
graphics region. 

You may need to zoom in on the model to select a valid entity. 
Since the entity selector is set to comps, selecting a line or surface in the component 
selects the entire component. 

5. In the panel, click the arrow button on the right under transparency several times. 

You should see the surfaces in the lvl10 component becoming more and more 
transparent. 

You can also drag the slider back and forth to control the level of transparency. 

6. Rotate, zoom, and pan to visualize the midsurface. 
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Close-up of the midsurface with the lvl10 component set to full transparency 

7. Click wireframe ( ) on the visualization toolbar. 

Step 4 (Optional):  Save your work. 
Now that the midsurface has been created, it is a good time to save the model. 

Summary 
We now have surfaces created on the mid-plane of the part.  These surfaces can now be 
meshed or further modifications can be made to their topology, depending on the 
requirements of the analysis. 
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Section 3: Simplifying Geometry 
This section looks at changing the shape of a part in order to simplify the geometry.  Certain 
details of the shape, such as small holes or blends, may simply not be necessary for the 
analysis being performed.  When these details are removed, the analysis can run more 
efficiently.  Additionally, mesh quality is often improved as well.  Changing the geometry to 
match the desired shape can also allow a mesh to be created more quickly. 

In this section, you will learn: 

• Mesh the clip, review the mesh quality, and determine the features to be simplified 

• Remove surface fillets 

• Remove edge fillets 

• Remove pinholes 
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Defeaturing 
There are many features on a part that are not critical to the structure of the part and have 
little or no effect on the analysis.  These features can include  

• Lightening Holes – For part weight reduction 
• Edge Filets – For reduction of sharp corners allowing safer part handling 
• Surface Fillets – To meet manufacturing requirements 

These features often are process driven and are not function critical.  While our goal is to 
mesh a part that as closely as possible accurately represents the geometry, these features 
often degrade the quality of the mesh.  As such they can be defeatured out of the design 
allowing for a substantially improved mesh with little impact on the results. 

 
Defeaturing Tools 

• Pinholes 
o Searches for holes within a surface.  Fills them in and leaves a fixed point at 

their previous center. 
• Surf Fillets 

o Searched for surfaces that act as a fillet between other surfaces and 
tangentially extends them to achieve a sharp corner. 

• Edge Fillets 
o Searches for rounded edge corner and squares them off. 

• Duplicates 
o Finds and deletes duplicate surfaces. 

• Symmetry 
o Identifies part symmetry and deletes or organizes the results.
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Exercise: Removing Details from a Midsurface Model 
This exercise uses the model file, clip_defeature.hm. The model file has geometry that 
has been midsurfaced. (Surfaces have been created on the mid-plane of the part.) The 
model will be meshed using an element size of 2.5. You can assume a simple structural 
analysis will be run on the part, and thus does not require much detail. Based on this, there 
are features, which are not necessary and can be removed. 

 

Step 1: Open and view the model file, clip_defeature.hm. 
1. From the File pull-down menu on the toolbar, click Open. 

2. Select the clip_defeature.hm.file and click Open. 

Step 2:  To easily work with the midsurface, turn off the display of the lvl10 
component. 
If the lvl10 component is displayed, it needs to be turned off so that you can easily work on 
the midsurface geometry. (It may be on if you used the model you had open for the previous 
section.) 

1. Navigate to the model browser. 
2. Verify that the Elements/Geometry selector is set to Geometry.  

3. If the geometry display for the the component lvl10 is selected as active, click the icon 
for the lvl10 component to turn off the display of the geometry in that component. 
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Step 3 (Optional):  Mesh the clip to view mesh quality before defeaturing. 

1. Click Shaded Geometry and Surface Edges ( ). 

2. Access the automesh panel: 

• From the Pull-down menu, choose Mesh, then Create, then 2D Automesh 

3. Set the selector type to surfs. 

4. Go to the size and bias sub-panel. 

5. In the element size = field, type 2.5. 

6. For mesh type:, select mixed.  

7. Switch the meshing mode from interactive to automatic.  

8. Verify that the elems to surf comp toggle is set. 

9. Select surfs >> displayed to select all displayed surfaces. 

10. Click mesh to generate the mesh preview. 

 
Initial mesh on the clip model 

11. Click return to go to the main menu. 

Step 4 (Optional):  Review the quality of the mesh. 
Take a minute to look over the mesh that was created. Note the areas that have irregular, 
poor quality mesh.  Also, use the check elems panel to evaluate the minimum length check 
of the elements. 

Take a minute to rotate, zoom, and pan the model to review the mesh that was created. 
Note the locations where the mesh was not created in neat rows and columns of quads. 

1. Access the check elems panel by doing one of the following: 
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• From the Pull-down menu, choose Mesh, then Check, then Elements, then Check 
Elements 

• From the main menu, select the Tool page, then select check elems 

2. Access the 2-d sub-panel. 

3. In the length field, type 1. 

4. Click length to evaluate the minimum length. 

Many of the elements failing the length test are located around the fillets of this model. 

 
 Elements failing the length check 

Note:  You may need to change the geometry display to wireframe for better 

visualization of element quality. For this, click Wireframe Geometry  ( ). 

5. Click return. 

6. Use the model browser to turn off the display of the elements in the lvl10 component. 

Step 5:  Remove the four small pinholes. 
Pinholes are closed free edge loops within a surface. Pinholes do not need to be circular.   

1. Access the defeature panel by doing one of the following: 

• From the Pull-down menu, select Geometry, then Defeature 

• From the main menu, click Geom Page, then click Defeature 

2. Go to the pinholes sub-panel. 

3. In the diameter field, type 3.0. 

4. Select surfs >> all.  
5. Click find to identify the pinholes having a diameter of 3 or less. 
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Notice the xP symbol at the center of the four circular holes. These symbols are 
highlighted in white, indicating they are pinholes identified by HyperMesh for removal.  

  
Pinholes identified using a 3 mm diameter 

6. Click delete to remove the selected pinholes in the model. 

The selected pinholes are removed and replaced by fixed points located at the center of 
the original pinholes. 

Step 6:  Remove all surface fillets in the clip. 
1. Go to the defeature panel. 

2. Go to the surf fillets sub-panel.  

3. If the surfaces are not shaded, click Shaded Geometry and Surface Edges ( ). 

4. To find fillets in displayed surfaces, select surfs >> displayed. 

5. In the min radius field, type 2.0. 

6. Click find to identify all the surface fillets with a radius of 2 or greater. 



Chapter 2: Geometry Clean-up 

HyperWorks 10.0  HyperMesh Introduction 79 
Proprietary Information of Altair Engineering, Inc. 

 
 

 
Surface fillets identified for removal 

7. Click remove. 

Step 7:  Automatically identify and remove rounded corners of surfaces. 
You should still be in the defeature panel. 

1. Go to the edge fillets sub-panel. 

2. Select surfs >> displayed.  

3. In the min radius field, type 1.0. 

4. Set the bottom switch to all to find all the fillets. 

5. Click find.  
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The edge fillets that meet the filter criteria are identified on the screen with an F symbol 
and radial lines marking the fillet beginning and end. 

 
Edge fillets identified for removal 

6. Notice that the selector moves down to the fillets entity selector. 

7. Right-click on one of the F fillet markers on the screen to deselect the fillet. 

8. Click remove to delete the selected edge fillets. 

All the fillets are removed.    

Step 8:  Mesh the defeatured geometry and view the quality. 
1. Go to the automesh panel. 

2. Select surfs>>displayed. 

3. Click mesh. 

Observe the mesh and you will notice that the mesh is created in rows of quads. 

Step 9 (Optional):  Save your work. 
Now that the model has been simplified, it is a good time to save the model. 

Summary 
The model is now represented in a much simpler form that suits the analysis that will be 
performed. Holes, surface fillets, and edge fillets were removed that were considered too 
small to be captured by the desired element size of 2.5. 



Chapter 2: Geometry Clean-up 

 

HyperWorks 10.0  HyperMesh Introduction 81 
Proprietary Information of Altair Engineering, Inc. 

 
 

Section 4: Refining Topology to Achieve a Quality 
Mesh 
Once a set of surfaces has been obtained that accurately reflects the intended shape for the 
analysis, further geometry cleanup may still be necessary.  Topological details of the 
geometry may affect the quality of the mesh created from the surfaces.  These details may 
not reflect any major feature of the part’s shape, and can be removed without concern.  
When modifying the topology affects the shape of the surfaces, a compromise must be 
made between the part shape and the element quality necessary for the analysis.  Other 
times, adding topological features that do not change the shape of the part may actually 
help create a better quality mesh. 

In this section, you will learn how to: 

• Mesh the part to determine poor element quality 

• Suppress small edges 

• Split surfaces 

• Remove interior fixed points 

• Replace closely placed fixed points 

• Create final mesh 
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Topology Refinement: Introduction 
• “Topology refinement

o Unlike defeaturing, this generally does not change the shape of the part. 
” is modifying topology in order to obtain a quality mesh 

• CAD geometry has topology details that interfere with mesh quality. 
o Edges are created where ever there is a change in surface curvature. 
o Even smooth areas can be split into several faces. 
o The automesher will be forced to place nodes along the edges and fixed 

points. 
o This may cause small element lengths, angles, aspect ratios, etc. depending 

on the shape of the model. 
• CAD geometry can also have surfaces with a complex outline. 
• Highly complex shapes can make it hard to get a quality mesh. 

o Adding in edges splits the surfaces into smaller and simpler regions which 
can be meshed easier. 

o Fixed points can be added in to force a node to be placed at that location, 
giving more control. 

 
Topology Refinement: Examples 

 
Topology Refinement: Tools 

• Edge edit  
o Toggle – Select a shared edge to suppress it. 
o (Un)Suppress – Select multiple edges to suppress all of them at once. 

• Point edit 
o Add – Add fixed points to help control mesh pattern. 
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 Especially helpful along edges to control node seeding. 
o Suppress – Removes unwanted fixed points. 
o Replace – Combines 2 fixed points at a single location. 
o Project – Projects fixed points onto a nearby edge. 

 Useful for aligning mesh between 2 edges. 
• Surface edit – All functions add edges by cutting surfaces 

o Adding edges can be useful for controlling mesh patterns in large areas. 
o Trim with nodes – Uses node locations to cut surfaces. 
o Trim with lines – Uses lines to cut surfaces. 
o Trim with surfs/plane – uses other surfaces or a defined plane to cut 

surfaces. 
• Quick edit 

o Split surf-node: Adds an edge to or divides a surface by cutting in a straight 
line between 2 selected nodes. 

o Split surf-line: Adds an edge to or divides a surface by cutting a straight line 
between a node and perpendicular to the selected line.  

o Washer split – Adds a circular edge around a hole in a surface Mostly used 
for creating all quad mesh around a hole. 

o Toggle – Same as edge edit panel. 
o Remove Point – Deletes a selected fixed point. 
o Replace point – Same as point edit panel. 
o Add/remove point : point – Creates a new fixed point at the selected 

locations. 
o Add point: line – Creates a user specified number of fixed points along the 

selected edge. 
o Project point – Same as edge edit panel. 

 



Chapter 2: Geometry Clean-up 

 

84 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

Exercise: Refining Topology to Achieve a Quality Mesh 

Step 1:  Open the model file, clip_refine.hm. 
The model for this exercise is clip_refine.hm. Take a few moments to observe the 
model using the different visual options available in HyperMesh (rotation, zooming, etc.). 

Step 2:  Create a preliminary mesh. 
1. Access the automesh panel  by doing one of the following: 

• From the Pull-down menu, select Create, then 2D Automesh 

• From the main menu, select the 2D page, then click automesh 

2. Set the selector type to surfs. 

3. Go to the size and bias sub-panel. 

4. In the element size = field, type 2.5.  

5. For mesh type:, select mixed. 

6. Switch the meshing mode from interactive to automatic.  

7. Select surfs >> displayed. 

8. Click mesh to mesh the surfaces. 

  
Initial mesh on the defeatured clip model 
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Step 3:  Review the mesh quality. 
1. Take a minute to rotate, zoom, and pan the model to review the mesh that was created.  

Note the locations where the mesh was not created in rows and columns of quads. 

2. Access the Check Elements panel by doing one of the following: 

• From the Pull-down menu, select Mesh, then Check, then Elements, then Check 
Elements 

• From the main menu, access the Tool page, and then click check elems 

3. Go to the 2-d sub-panel. 

4. In the length field, type 1. 

5. Click the length button to evaluate the minimum length. 

6. Note the elements that failed the check. The topology will be edited to correct some of 
these, and the others will be left as is. 

7. Click return to return to the main menu. 

8. Use the model browser to turn off the display of the elements in the lvl10 component. 

Step 4:  Remove short edges by combining fixed points. 
1. Access the point edit panel by doing one of the following: 

• From the Pull-down menu, select Geometry, then Edit, then Points. 

• From the main menu, select the Geom page, and then click point edit 
2. Go to the replace sub-panel. 

3. Verify that the active selector is set to moved points. 

4. Select the lower fixed point as indicated in the following image. 

5. Once the point is selected, activate the retained point button. 

6. Select the upper fixed point as indicated in the following image.  

7. Once the second point is selected, click replace. 
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Selecting fixed points to be combined 

Step 5:  Remove the fixed points interior to all surfaces. 
1. You should still be in the points panel. 

2. Go to the suppress sub-panel and choose at cursor option. 

3. Select the four fixed points as shown in the following image. 

Each fixed point will be deleted as you select it. 

These fixed points are left over from a defeaturing operation where small holes were 
removed. They could remain without greatly sacrificing the element quality, given the 
element size used for the mesh. 



Chapter 2: Geometry Clean-up 

 

HyperWorks 10.0  HyperMesh Introduction 87 
Proprietary Information of Altair Engineering, Inc. 

 
 

  
Fixed points to be removed 

4. Click return to go to the main menu. 

Step 6:  Add edges to the surfaces to control the mesh pattern. 
1. Access the surface edit panel by doing one of the following: 

• From the Pull-down menu, select Geometry, then Edit, then Surfaces. 

• From the main menu, select the Geom page, then select surface edit. 
2. Go to the trim with nodes sub-panel. 

3. Under node normal to edge, set the active selector to node.  

4. Zoom into the area indicated below and select the indicated fixed point. 

5. With the active selector now on lines, select the line shown in the following image. 
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Once both the point and line are selected, an edge will be created from the location of 
the fixed point perpendicular to the line. 

  
Select fixed point and line to split the surface. 

6. Repeat #3, #4 and #5 for the following point and line. 

  
Select fixed point and line to split the surface. 
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7. Repeat #3, #4 and #5 for the following point and line. 

  
Select fixed point and line to split the surface. 

8. Repeat #3, #4 and #5 for the following point and line. 

  
Select fixed point and line to split the surface 
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Step 7:  Add edges to the surfaces to control the mesh pattern. 
1. Access the surface edit panel. 

2. Go to the trim with surfs/planes sub-panel. 

3. In the with plane column, set the active selector to surfs.  
4. Select the surfaces indicated in the following image. 

  
Surfaces to be selected for splitting 

5. If necessary, toggle the direction selector to N1, N2, and N3. Click N1 to make the 
selector active. 

6. Press and hold your left mouse button, and then move it over the edge indicated in the 
following figure.  

Once over the line, the cursor will change to a square with a dot in the center, . 
Release your mouse button.Click two points anywhere along the edge. Do not click a 
third. 

Nodes will be placed on the line for N1 and N2. 

7. Press F4 on the keyboard to enter the distance panel. 

8. Go to the three nodes sub-panel. 

9. As in step #6, press and hold your left mouse button, and then move it over the edge of 
the hole, as indicated in the following image. Once over the line, the cursor will change 
to a square with a dot in the center. Release your mouse button. 
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Select fixed point and line to split the surface 

10. Click three points anywhere along the edge. 

Temporary nodes will be placed on the line representing N1, N2 and N3. 
Note that the technique used to create nodes to select where none existed before can 
be used in any place where nodes need to be selected but don’t exist in the model. You 
can create nodes in this manner on lines, surfaces and elements. For more details, see 
the HyperMesh online help. Pick the index and type, Picking Nodes on Geometry or 
Elements. 

11. Click circle center to create a node at the center of the hole. 

12. Click return to go to the surface edit panel. 

13. Click B to make it the active selector. 

14. Select the node that was just created at the center of the hole. 

15. Click trim. 

16. Click return to go to the main menu. 

The surfaces are trimmed through the center of the hole. 

Step 8:   Suppress shared edges causing a small edge. 
1. Go to the edge edit panel. 

2. Go to the (un)suppress sub-panel. 

3. Select each of the lines in the image below using your left mouse button and click 
suppress. 



Chapter 2: Geometry Clean-up 

 

92 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

Each line will become suppressed (blue) as you click suppress. 

  
Surface edges to suppress by toggling 

Step 9:  Remesh the part. 
Remesh the surfaces of the part, using the automatic mode, a size of 2.5, and the mixed 
mesh type. 

1. Use the model browser to display the elements in the lvl10 component.  

2. Access the automesh panel. 

3. Verify that elem size = is set to 2.5 and the mesh type is set to mixed. 

4. Select surfs >> displayed to select all displayed surfaces. 

5. Click mesh. 

Step 10:  Review the mesh quality. 
1. Take a minute to rotate, zoom, and pan the model to review the mesh that was created. 

Note that the mesh now consists completely of rows and columns of quads. 

2. Enter the Check Elements panel. 

3. Go to the 2-d sub-panel 

4. In the length field, type 1. 

5. Click the length button to evaluate the minimum length. 



Chapter 2: Geometry Clean-up 

 

HyperWorks 10.0  HyperMesh Introduction 93 
Proprietary Information of Altair Engineering, Inc. 

 
 

Note the elements that failed the check. There are only two elements, and these fail the 
check because of the shape of the part. However, they are not too small compared to 
the global element size, so you can leave them as they are. 

6. Access the automesh panel. 

7. Go to the QI optimize sub-panel. 

8. Verify that elem size = is set to 2.5 and the mesh type is set to mixed. 

9. Click edit criteria. 

10. In the Target element size field, type 2.500. 

11. Click Apply and OK. 

12. Select surfs >> displayed to select all displayed surfaces. 

13. Click mesh. 

Note that the old mesh is replaced by the new mesh. 

14. If there is a message saying, "There is a conflict between the user requested element 
size and quality criteria ideal element size," click the button, Recompute quality criteria 
using size of 2.5. 

15. Access the qualityindex panel by doing one of the following: 

• From the Pull-down menu, select Mesh, then Check, then Elements, then Quality 
Index 

• From the main menu, select the 2D page, then select qualityindex 

16. Go to pg1 and verify that the comp. QI is 0.01. (If your value is higher than this 
number than you can try to recalculate by going back to Step 6 and performing 
the steps again, selecting the surfaces before entering the 2.5 element size.) 
This low value indicates that the mesh is good quality. The higher the number, the lower 
the mesh quality. 

Step 11 (Optional):  Save your work 
The part is now meshed and ready to be set up for an analysis. Save the model, if desired. 
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Chapter 3 

Shell Meshing 
Section 1: AutoMeshing 
The optimal starting point for creating a shell mesh for a part is to have surface geometry 
defining the part. The most efficient method for creating a mesh representing the part 
includes using the automesh panel and creating a mesh directly on the part’s surfaces.  

The automesh panel is a key meshing tool in HyperMesh. Its meshing module allows you to 
specify and control element size, density, type, and node spacing, and also perform quality 
checks before accepting the final mesh.  

A part can be meshed all at once or in portions. To mesh a part all at once, it may be 
advantageous to first perform geometry cleanup of the surfaces, which can be done in 
HyperMesh.  

The optimal starting point for creating a shell mesh for a part is to have geometry surfaces 
defining the part. The most efficient method for creating a mesh representing the part 
includes using the automesh panel and creating a mesh directly on the part’s surfaces.  

The purpose for this section is to help you become proficient with using the automesh 
panel’s meshing module. In this section, you will learn how to: 

• Mesh all the surfaces at once specifying different element sizes and element types. 

• Practice changing the element density along surface edges.  

• Practice checking element quality and changing the mesh pattern by changing the 
mesh algorithm. 

• Preview the mesh on all the unmeshed surfaces. 

• Practice changing the element type and node spacing (biasing) along surface edges. 

• Re-mesh surfaces. 
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Automeshing 
The Automesh function in HyperMesh allows for the rapid generation of a quality mesh on 
one or multiple surfaces.  Within the automesh panel there are many options available which 
provide the user a high level of control over the ultimate mesh. 

 

 
 

Topology Review 
Automeshing of surfaces is dependent on surface topology, which is the connection of 
adjacent surfaces edges.  Properly connected edges ensure a properly connected mesh.  
As discussed, in greater detail, in the previous chapter, topology is represented graphically 
though edge color.  

 
Mesh Connectivity 
To properly represent a part with shell elements, those elements must be properly 
connected.  Unconnected elements are in effect a slice in a part and all stresses, strains and 
deformations will stop at the unconnected region.   
HyperMesh maintains edges in a part.  This means that if you see a surface edge in the 
mesh (unless it is suppressed) you will see that same edge in the mesh.  HyperMesh will 
place nodes along that edge and if the edge is properly connected then there will only be 
one set of nodes that will be shared by elements on either side of the edge.  Node sharing 
between multiple elements is how elements are connected to each other. 



Chapter 3: Shell Meshing 

HyperWorks 10.0  HyperMesh Introduction 97 
Proprietary Information of Altair Engineering, Inc. 

 
 

Mesh Connectivity cont. 
Below are examples of how edge topology affects the resultant mesh.  There is an example 
for each of the 4 topological states (colors). 
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The Automesh Panel 

 
Within the automesh panel are numerous controls to allow for the creation of a quality mesh 
to individual specifications.   
 Newly added to HyperMesh 10.0 are the Align and Size options on the Automesh 

panel. 
Flow:Align produces a more orthogonal quad dominated mesh 

 

Flow:Size is active only when align is used and it enforces the global mesh element 
size with minimal min/max element size variation 

Mesh with no flow control 

 
 
Mesh with Align Control 

 
 
Mesh with Align and Size Control 
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Size and bias Subpanel 
This subpanel is the most widely used and is the default for automeshing.  Within this panel 
the user sets the desired element size and type, chooses options for flowing and mapping 
and then is provided with a preview mesh.  From within the meshing module there are many 
options for mesh refinement. 

 
• Density 

o Adjust – Left clicking on an edge will raise the element density on that edge 
by one, right cliking will lower the density by one.  Clicking  
will provide a new preview mesh with the changes. 

o Calculate – Here the user can enter a new element size and either click on 
an edge to recalculate the density on that edge or click recalc all and change 
the element size for all the surfaces currently being meshed.  

o Set – This option allows for the setting of element densities on a single or all 
edges to a user set number.  

• Mesh Style 
From this sub panel the user can indicated the type of mesh to create. 
 
 
 
 
. 
 

  
 

 This panel also allows the user to define the method or style of meshing.  The “style” 
 is the manner in which the mesh transitions between different density values. 
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• Biasing 
The biasing subpanel allows the user to control the distribution of nodes during the 
nodes seeding by selecting biasing in the form of linear, exponential or bell curve 
distributions. 

 
 

• Checks 
The checks subpanel evaluates the quality of the generated mesh. 

 
 

• General Controls 

 
 

 
This toggle changes between automatic and interactive meshing modes.  In automatic 
mode, HyperMesh will generate the mesh based upon the user entered values and options.  
In the interactive mode HyperMesh will generate the same mesh but will do so as a 
“preview” mesh allowing the user to use the above mentioned tools to manipulate the mesh 
before finalizing it.
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Exercise: Meshing a Channel Bracket  
This exercise uses the model file, channel.hm. 

 

Step 1:  Open and view the model file, channel.hm. 
Take a few moments to observe the model using the different visual options available in 
HyperMesh (rotation, zooming, etc.). 

Step 2:  Mesh all the part’s surfaces at once using an element size of 5 and the 
mixed element type (quads and trias). 
1. Access the automesh panel in one of the following ways: 

• On the Mesh pull-down menu, select Create, and click 2D AutoMesh 

• From the main menu, select the 2D page, and then select automesh 

2. Go to the size and bias sub-panel. 

3. Select surfs >> displayed. 

4. For element size=, specify 5. 

5. Set the mesh type: to mixed. 

6. On the panel’s bottom-left corner, set interactive as the active mesh mode (it may 
currently be on automatic). 

7. Check the message bar at the bottom and verify that the current component collector is 
Middle Surface. 

8. Ensure that the elements to surf comp/elements to current comp toggle is set to elems 
to current comp. 

9. Click mesh to enter the meshing module. 
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Notice that you are in the density sub-panel of the meshing module. There is node 
seeding and a number on each surface edge. The number is the number of elements 
that were created along the edge. 

10. Click return to accept the mesh as the final mesh. 

At this point, you could be done using the automesh panel to mesh the part. The mesh 
quality is very good. However, you will remain in the meshing module to perform the next 
steps, which demonstrate how to use various sub-panels to interactively control the 
creation of the mesh. 

Step 3:  Delete the mesh. 
1. Access the delete panel in one of the following ways: 

• On the Collectors toolbar, select Delete ( ) 

• Press F2 on the keyboard 

2. Switch the entity selector to elems. 

3. Select elems >> all. 
4. Click delete entity. 

5. Click return to go back to the automesh panel. 

Step 4:  Mesh the surface having three fixed points interior to its surface.  
You should still be in the automesh panel, size and bias sub-panel. 

1. Leave all options in the menu panel as they are.  

2. Select the surface that has three fixed points interior to its surface. 

3. Click mesh to enter the meshing module. 

4. Preview the mesh generated.  

Step 5:  Fit only the surface being meshed to the graphics area. 
Fit the surface to the Graphics area in one of the following ways. 

• On the density sub-panel, click f.  

• Click local view > fill or click local view and pick fill.   

Step 6:  From the graphics area, specify a new element density along surface 
edges. 
1. From the density sub-panel, click the selector, adjust : edge to make it active. 

2. From the Graphics area, left-click an edge’s element density number to increase it by 
one. 

3. Right-click an edge’s number to decrease it by one. 



Chapter 3: Shell Meshing 

HyperWorks 10.0  HyperMesh Introduction 103 
Proprietary Information of Altair Engineering, Inc. 

 
 

4. Click and hold the mouse pointer on an edge’s number and drag the mouse up or down 
to increase or decrease the number.  

5. Click mesh to update the preview mesh based on the change.  

Step 7:  From the menu panel, specify a new element density along surface 
edges. 
You should still be in the density sub-panel. 

1. For elem density=, enter 10. 

2. Activate the selector set : edge . 

3. Click an edge’s number to change its value to 10.  

4. Update the mesh by clicking mesh to preview the change. 

5. Change all edge densities to 10 by clicking set all to.  

6. Click mesh to preview the change. 

Step 8: From the menu panel, specify a new element size to adjust element 
densities along surface edges. 
You should still be in the density sub-panel. 

1. For elem size=, enter 7. 

2. Click calculate: edge to make it the active selector. 

3. Click an edge’s number to calculate it based on an element size of 7. 

The new number is calculated to create elements as close to a size of 7 as possible. 

4. Click mesh to preview the change. 

5. Click recalc all to base all edge densities on an element size of 7. 

6. Click mesh to preview the change. 

Step 9:  Change all edge element densities to reflect the initial element size of 
5. 
1. For elem size=, specify 5.  

2. Click recalc all. 
3. Click mesh to preview the change. 

4. Return to accept the mesh and go back to the size and bias sub-panel. 

Step 10:  Preview a mesh of the channel’s rib. 
You should still be in the automesh panel, size and bias sub-panel. 

1. With the surfs selector active, select the rib surface in the middle of the part. 
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2. Leave all options in the menu panel set they are.  

3. Click mesh to enter the meshing module. 

4. Preview the mesh generated.  

5. Click local view and pick the rear view to display the rib’s surface in this position, filled to 
the Graphics area.  

Step 11:  Check the quality of the rib’s preview mesh. 
1. Go to the checks sub-panel. 

2. Click aspect to identify all elements having an aspect ratio greater than 5.  

3. Notice that no elements fail this check. In the status bar, the highest aspect ratio value 
reported is 1.72. 

4. For jacobian specify 0.8. 

5. Click jacobian to identify all elements having a jacobian less than 0.8. 

6. Notice that several elements fail this check and are outlined red. The status bar reports 
the smallest jacobian value to be 0.71. 

7. Change the jacobian check value back to 0.7. 

8. Verify that no elements have a jacobian less than 0.7. (Click jacobian.) 

9. Check for quad elements having a min angle less than 45. 

10. Smallest angle is _____. 

11. Check for quad elements having a max angle greater than 135.  

12. Largest angle is _____. 

Step 12:  Change the rib’s mesh pattern by changing the mesh method used 
for its surface. 
1. Go to the mesh style sub-panel. 
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2. Notice that the edges’ element density numbers disappear. Interior to the rib’s surface is 
a white icon. It indicates the free (unmapped) mesh method is currently being used to 
mesh the surface. 

 
Mesh on rib using the free (unmapped) mesh algorithm 

3. Under mesh method: set the option to map as rectangle (autodecide is default).  

4. Click set all found under mesh method. 

5. Notice that the icon changes to reflect the new mesh method. 

6. Click mesh to preview the change. 

 
Mesh on rib using the map as rectangle mesh algorithm 
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Step 13:  Check the quality of the rib’s preview mesh again. 
1. Go the checks sub-panel. 

2. Check for elements having an aspect ratio greater than 5. 

Highest value reported is _____. 

3. Check for elements having a jacobian less than 0.7. 

Lowest value reported is _____. 

4. Check for quad elements having a min angle less than 45. 

Smallest value reported is _____. 

5. Check for quad elements having a max angle greater than 135. 

Highest value reported is _____. 

6. Notice that in this case, the free (unmapped) mesh has better jacobian than the map as 
rectangle mesh.  

Step 14:  Change the rib’s mesh method back to free (unmapped). 
1. Go to the mesh style sub-panel. 

2. Under mesh method:  set the option to free (unmapped).  
3. Click set all found under mesh method. 

4. Click mesh to preview the change. 

5. Click return to accept the mesh as final and go back to the automesh panel. 

Step 15:  Preview a mesh of all displayed, unmeshed surfaces. 
You should still be in the automesh panel, size and bias sub-panel. 

1. Press V on the keyboard, and select iso 1. 

2. Move your mouse off the pop-up menu to return to the automesh panel. 

3. Accept all the default values. 

4. On the menu panel’s bottom-right side, click failed surfs. 

The status bar displays the following message: "There are no surfaces with meshing 
errors". This is correct; all surfaces you selected to mesh so far have a mesh on them. 

5. Click unmeshed surfs to identify and select all displayed unmeshed surfaces.  

6. Click mesh to enter the meshing module. 

7. Preview the mesh generated. 

Step 16:  Change the element type for some surfaces to trias.  
1. Go to the mesh style sub-panel. 

2. Click toggle surf found under elem type.   
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Notice that interior to each surface is a blue icon. It indicates the mixed element type 
(quads and trias) is currently being used to mesh the surface. 

3. Under element type: select the menu trias.  

4. Under element type: activate the selector set surf. (Click set surf.) 
5. Left-click the blue icon twice in each of the channel’s bottom two surfaces to set their 

element type to trias.  

6. Click mesh to preview the change. 

 
Preview of mesh with trias element type for the bottom two surfaces  

Step 17:  Adjust the node spacing on surface edge (biasing). 
1. Go to the biasing sub-panel. 

2. Notice the bias intensity number (default 0.000) on each surface edge. 

3. Leave the bias style set to linear. 
This style corresponds to the positive slope of a straight line over the interval [0,1] of the 
real line. For a positive bias intensity, smaller elements are at the start of the edge.  

4. Verify that the selector adjust: edge is active. 
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5. Left- or right-click the edge biasing intensity number as indicated in the image below to 
increase or decrease its value by 0.1. 

 
Preview mesh in the biasing sub-panel 

6. Click and hold the mouse pointer on the same edge biasing intensity number and drag 
the mouse up to increase its value to 3.0.  

5. Click mesh to preview the change. 

6. For intensity= enter 10. 

7. Activate the selector, calculate: edge. 

8. Click the same edge’s bias intensity value to change it to 10. 

9. Click mesh to preview the change. 

10. Switch bias style: to bellcurve. 

This style distributes nodes along the edge in a pattern that is symmetric across the 
midpoint of the edge. For a positive biasing intensity, the smaller elements are at the 
start and end of the edge.  

11. Activate the selector set: edge, to make it active. 

12. Click the same edge’s blue icon to change it from linear bias style to bellcurve bias 
style. 

13. Click mesh to preview the change. 

14. Click return to accept the final mesh and go back to the automesh panel. 

Step 18:  Remesh the channel’s bottom two surfaces. 
You should still be in the automesh panel, size and bias sub-panel. 

1. On the panel’s bottom-left side, switch the mesh mode from interactive to automatic. 
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This mode is not interactive; it does not take you to the meshing module. Rather, it 
meshes surfaces using only the basic parameters of the automesh panel. Interactive 
mode can be used to remesh the surfaces if you require the different options to control 
the created mesh.  

2. With the surfs selector active, select the channel’s bottom two surfaces (having the tria 
mesh). 

3. Set element size = to 10. 

4. Click Mesh to delete the existing mesh on the surfaces and create a new mesh. 

5. Observe the resulting quad mesh on the remeshed surfaces. 

 Note that connectivity was maintained with the surrounding, smaller mesh. This is 
because the break connectivity option was not used. 

6. Click return to go to the main menu. 

 
Remeshed surfaces with element edge densities 

Step 19 (Optional):  Save your work. 
Meshing of the channel part is complete. Now is a good time to save the model. 
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Section 2: Checking and Editing Mesh 
Once a mesh is created, HyperMesh has many tools for checking element quality and 
modifying the mesh to make it more desirable.  These tools can be used at almost any point 
in the meshing process.  This section is separated from sections on creating mesh so that 
the focus can be on checking and editing tools. 

In this section, you will learn how to: 

• Identify shell element connectivity problems. 

• Correct shell element connectivity problems. 

• Review the model’s shell elements to ensure connectivity problems were corrected. 

• Re-mesh the elements along the rib. 
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Checking and Editing the Mesh: Tools 
These mesh editing tools can be found on the 1D, 2D and 3D pages and can also be 
reached through the Mesh>Edit>Elements pull-down. 

 
 

• Edit element 
• Combine – merge 2 or more elements into 1 single element 
• Split – draw a line to cut elements 
• Cleanup – interactively drag nodes to improve element quality 

• Split – divide selected elements in a selected manner 
• Replace – merge 2 nodes into 1 node (elements are now connected) 
• Detach – disconnect selected elements from other elements 
• Smooth – improves quality of selected elements 
• Quality index 

• Set criteria for all standard quality checks 
• Simultaneously evaluate element quality 
• Combine all checks into a single value called “composite quality index value” 
• Edit nodes and elements interactively or by automatically maximizing element 

quality  
These tools can be found on the Tool page. 

 
• Check Elems – evaluate elements against various element quality criteria 

• Jacobian, warpage, angle, min. length, aspect ratio, skew 
• Edges 

• Display free edges in the model by creating 1D elements on each one 
• Equivalence (merge) nodes within a specified tolerance 

• Normals – display and correct element normals  
• Penetration – display and correct element penetration 
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Exercise: Mesh Clean-up of a Plastic Cover  
This exercise uses the model file, cover.hm. 

 

Step 1:  Retrieve and view the HyperMesh model file. 
Open the file cover.hm located in the <installation folder>\tutorials\hm 
directory. 

Step 2:  Review the model’s free edges to identify shell element connectivity 
problems. 
1. Access the edges panel in the following ways: 

• From the Pull-down menu, select Mesh, then select Check, then Components, 
then Edges 

• From the main menu, select the Tool page, and then click edges 

• Press the SHIFT+F3 keys 

2. With the comps selector active, click  any element in the Graphics area. 

The component containing the element is selected.  

3. Click find edges. 
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Red, 1-D elements are displayed. They are organized into the new component named 
^edges.  A red 1-D element is created along each shell element edge that is free; one or 
more of the element edge’s nodes is not shared by the adjacent elements. 

Note: For a component name whose first character is ^, the component and its 
contents is not written to the input file when the model is exported. 

4. Click Shaded Elements & Mesh Lines ( ).  

5. Observe the red, 1-D elements (free edges). 

6. Try to identify gaps in the continuity of the mesh.  

Hint: Look closely at free edges interior to the model.   

7. In the model browser, turn the display on and off for the component, shells, to continue 
to identify which red, free edges do not belong. 

  
8. Turn on the display for the component, shells. 

Step 3:  Correct the shell element connectivity problems using the edges 
panel. 
1. In the tolerance= field, type 0.01. 

2. Click preview equiv. 

The status bar displays the following message, "81 nodes were found." 

A sphere, ,is created on nodes having a distance between each other equal to or less 
than the specified tolerance.   

3. Notice that for this exercise’s model, a sphere is not created on every node along all of 
the red, free edges, which do not belong. A larger tolerance must be specified to identify 
the rest of the nodes.  

4. For tolerance =, increase its value until all 96 nodes are identified as shown in the 
following image. 

Be careful not to increase the tolerance value to too much. Although the 96 nodes will be 
identified, an excessively large tolerance value may collapse elements when the 
identified nodes are equivalenced. To find out the maximum value that can be safely 
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used for tolerance without collapsing the elements, press the F10 key to go to the check 
elems panel, go to 2-d sub-panel and click on length. The status bar will display ‘… The 
min length is 1.49’. A tolerance value < 1.49 can safely be used, without causing any 
elements to collapse when identified nodes are equivalenced. Click return to go back to 
edges panel. 

 
The nodes identified with preview equivalence 

5. Click equivalence. 
The 96 coincident nodes are equivalenced. 

6. Rotate and observe the model to see that the mesh still looks as it should and no 
elements are collapsed. 

7. Click delete edges. 

The red, free edges and their component, ^edges, are deleted.  

8. Remain in the edges panel. 

Step 4:  Review the model’s free edges again to confirm that all of the shell 
element connectivity problems have been corrected.  
1. Click find edges. 

Observe the red, 1-D elements (free edges). 

Are there any red, free edges that should not belong if the mesh were continuous or if all 
of the elements were connected?  

Hint: Only red, free edges should exist on the perimeter of the part and on periphery of 
internal holes. 

2. Use the model browser to turn the display off and on for the component, shells, to 
observe that all of the free, red edges belong. 
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3. After verifying that the model has correct red, free edges, click delete edges. 

 
Red, free edges that belong 

Step 5:  Display the element normals and adjust them to point in the same 
direction. 
1. Go to the normals panel. The normals panel can be accessed in the following ways: 

• From the pull-down menu, select Mesh, then Check, then Elements, and then 
Normals 

• From the main menu, select the Tool page, then click normals 

• Press the SHIFT+F10 keys 

 Choose the elements sub-panel and set toggle to vector display normals. 

2. With the comps selector active, select one element from the graphics area to select the 
component. 

3. Click display normals. 

Arrows (vectors) are drawn from the element centroids and show the direction of the 
element normals.  

Notice the arrows do not all point from the same side of the part. For some analyses, the 
element normals should point from the same side.  

4. Click size = and enter the size which the normal should be in model units and select 
display normals again.  

When size = is set to zero, the vector will be 10% of the screen.   

5. Toggle vector display normals to color display normals. 

6. Click display normals. 
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The element normals are displayed using colors. The red side of the elements is the 
positive normal direction, while the blue side is the negative normal direction. 

7. Notice each side of the part shows red and blue. 

8. Click the orientation: elem selector to make it active.  

9. Select an element from the graphics area. 

10. Click adjust normals. 

All elements on either side of the part are the same color, red or blue. 

The status bar displays the following message, "[X] elements have been adjusted." 

If after adusting the normals, there are still elements on one side of the part which are of 
different color, change to elems from comps for the entity selector, choose these 
elements and click reverse normals.   

11. Click return. 

Step 6:  Review the quality of the elements using the check elems panel. 
1. Access the check elems panel in one of the following ways: 

• From the Pull-down menu, select Mesh, then Check, then Elements, and then 
Check Elements 

• From the main menu, select the Tool page, then click check elems 

• Press the F10 key 

2. Go to the 2-d sub-panel. 

3. Verify that jacobian < field is set to 0.7. 

4. Click jacobian to determine if any elements have a jacobian of less than 0.7.  

Elements having a jacobian of less than 0.7 are highlighted. 

5. Notice that several elements on the triangular rib and around the smaller of the two 
holes have a jacobian of less than 0.7. 

The status bar displays a message indicating how many elements failed this check. 

6. In the graphics area, click an element. 

A window displays that lists each quality check result for the element.  

7. Click the right or left mouse button to close the pop-up window. 

8. On the right side of the panel menu, switch from standard to assign plot. 
9. Click jacobian to review again.  

A legend for jacobian values appears and each element is colored accordingly. The red 
elements have a jacobian less than the threshold, 0.7. 

10. Verify that quads: min angle < is set to 45. 

11. Click min angle to determine if any quad elements have an angle of less than 45.  

12. Notice that a couple of elements on the rib have an angle of less than 45. 
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13. Verify that the max angle >field is set to 135.  

14. Click max angle to determine if any quad elements have an angle greater than 135. 

15. Notice that several elements on the rib have an angle greater than 135. 

16. Click return. 

Step 7:  Remesh the elements on the rib using the automesh panel. 
1. Access the automesh panel in one of the following ways: 

• From the Pull-down menu, select Mesh, then Create, and then 2D Automesh 

• From the main menu, select the 2D page, then click automesh 

• Press the F12 key 

2. Verfiry that you are in the size and bias sub-panel. 

3. Switch the entity selector to elems. 

4. Toggle to interactive. 

5. For element size=, type 3.5. 

6. Select one rib element from the graphics area. 

7. Select one element on the plane of elements perpendicular to the rib and in the same 
plane as the rib’s shortest edge as shown in the following image. 

 
Example of elements to select  

8. Select elems >> by face to complete the selection of elements as shown in the following 
image. 
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Elements selected using by face  

9. Click mesh. 

The meshing module appears. 

10. In the density sub-panel, change the element density on the rib’s hypotenuse edge to 9.  

11. Change the element density on the rib’s shortest edge to 5. 

12. Keep all other element edge densities the same. 

  
Adjusting element edge densities 

13. Access the mesh style sub-panel. 

14. Under mesh method, set the last option to free (unmapped). 
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15. Under mesh method, select set all. 
16. Click mesh to preview the mesh. 

17. Go to the checks sub-panel, and check the jacobian, quads: min angle, and quads: max 
angle. 

18. Notice that no elements fail the minimum and maximum angle checks. 

Only a couple of elements have a jacobian of less than 0.7. The smallest jacobian is 
0.68, which can still be considered good quality. 

19. Click return to accept the mesh and go back to the main menu.  

Step 8:  Remove the tria elements from the rectangular plane of remeshed 
elements by first deleting the row of elements containing the trias. 
1. On the Tool page go to the delete panel. 

2. Ensure that elems is the active selector. 

3. Select the elements as shown in the following image.  

4. Click delete entity. 

5. Click return. 

 
Elements to delete 

Step 9:  Stitch the gap that resulted from deleting the row of elements using 
the replace panel.  
1. On the 2D page, enter the replace panel and verify that just equivalence is checked. 

2. With the replace: node selector active, select node A as indicated in the following 
image. 

3. With the with: node selector active, select node B as indicated in the following image. 



Chapter 3: Shell Meshing 

 

HyperWorks 10.0  HyperMesh Introduction 121 
Proprietary Information of Altair Engineering, Inc. 

 
 

Node A is replaced with node B. 

 
Select nodes A and B 

4. Repeat #2 and #3 for the other nodes along the gap.    

The resulting mesh should look like the mesh in the following image. 

 
The mesh after replacing nodes on the bottom face 

5. Click return. 



Chapter 3: Shell Meshing 

122 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

Step 10:  Use the smooth panel to adjust the node placement on the 
rectangular plane of remeshed elements. 
1. On the 2D page, enter the smooth panel. 

2. Go to the plates sub-panel. 

3. With the smooth: elems selector active, select an element on the rectangular plane of 
re-meshed elements. 

4. Select elems >> by face. 

5. For iterations = specify 10. 

6. Switch the smoothing algorithm from autodecide to shape corrected. 

7. Click smooth. 

8. Click return. 

Step 11:  Remove tria elements from another area of the model using the edit 
element panel, split and combine sub-panels. 
1. On the 2D page, enter the edit element panel. 

2. Go to the split sub-panel. 

3. With the splitting line: points selector active, click four screen points as shown the 
following image. 

Temporary line segments are drawn to connect the points.  

4. You can right-click to undo the last line segment drawn or you can click delete line to 
start over with selecting points. 

 
5. Click split. 
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Elements that have the line pass through them are split. The resulting mesh should look 
like the mesh below. There are two pairs of adjacent tria elements. 

 
6. Go to the combine sub-panel and set the toggle to combine to quad. 

7. Select two adjacent tria elements as indicated in the following image.  

8. Click combine. 

9. Repeat # 7 and # 8 for the other two adjacent tria elements. 

10. Remain in the Edit Element sub-panel. 

 
  Trias to select  Combining trias into quads 

Step 12:  Dynamically move nodes on the mesh area modified in the last step 
to improve element quality. 
1. Go to the cleanup sub-panel and ensure it is set to displayed elems. 

2. Click cleanup. 

The element cleanup menu appears. It allows you to select various combinations of 
quality checks, specify a warning/unacceptable range for each check, and dynamically 
move nodes around to place them where you desire. 

Elements are colored as follows: 



Chapter 3: Shell Meshing 

124 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

• No color; appear blank: element passes quality checks  

• Yellow: one or more quality check results falls into warning/unacceptable range 

• Red: one or more quality check results are beyond unacceptable 

Among the group of elements you modified in the last step, Step 11, two quad elements 
are red and one quad element is yellow. 

3. Clear the warpage and jacobian check boxes, so that just the max angle is checked. 

4. The model has 3 elements that are colored red. 

5. With the node selector active, click an interior node of a red element and drag the node 
around until the element is no longer red. 

6. Repeat # 4 for the other red elements. 

7. Click return. 

Step 13:  For the same area of elements you focused on in the last step, 
optimize element quality by clicking nodes and elements. 
1. On the 2D page, go to the qualityindex panel. 

2. With the node optimize selector active, click a few nodes of the mesh area you 
modified. 

When a node is clicked, it is repositioned so that the elements attached to it have the 
best possible quality based on the criteria specified in the qualityindex panel. 

3. Click the selector element optimize to make it active. 

4. Click yellow and red elements in the same mesh area.  

When an element is clicked, it is adjusted to have the best quality possible based on the 
criteria specified in the qualityindex panel. 

When you click a red element, it may become yellow or black (no color assigned). When 
you click a yellow element, it may become black. 

5. Click return. 

Step 14:  Add a ring of radial elements around the smaller of the two holes. 
1. Click the Utility tab. If the Utility Menu is not displayed in the HyperMesh session, go to 

View menu and check Utility Menu 

2. On the Geom/Mesh page, click Add Washer. 
3. With the nodes selector active, select one node on the edge of the smaller hole as 

indicated in the following image. 
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 Example node to select 

4. Click proceed.  

A pop-up window for the ‘Add Washer …’ utility appears. 

5. Toggle to Width, and for Value specify 3.0.  

6. Select the Minimum number of nodes around the hole check box. 

7. In the Density: field, enter 12. 

 
Add Washer dialog 
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8. Click Add. 

9. Click Close. 

The mesh around the hole should look like the mesh in the following image. 

 
 Resulting mesh around the smaller hole 

Step 15 (Optional):  Save your work. 
With this exercise completed, you can save the model if desired. 
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Section 3: Batch Meshing 
Geometry cleanup and meshing are often cited as time consuming aspects of finite element 
modeling. In HyperMesh, these tasks can be performed in batch mode with the Batch 
Mesher, requiring a minimum of input and user interaction.  This section walks the user 
through the basic process of meshing a part using the batch mesher. 

In this section, you will learn how to: 

• Define a configuration for the batch mesh 

• Edit the criteria and parameter files 

• Run the batch mesh job 

• Monitor and review the batch mesh job 
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Batchmesher 
• Performs geometry cleanup and automeshing in a batch mode 

• Can dramatically improve productivity since there is minimal user interaction 
(especially for large assemblies) 

• Uses criteria and parameter files to determine how the parts should be meshed 
 

• Can mesh multiple files in the same run 

 
 
Batch Meshing Procedure 

1. Create / specify Configurations  
• Combination of element criteria and 

geometric parameters. 
• Element criteria are element 

quality requirements. 
• Geometric parameters are other 

requirements (element type, 
removal of pinholes, removal of 
fillets, etc.) 

• Criteria and parameters can be edited 
with the Criteria and Parameters Files 
Editor. 

 
 
 

2. Register and specify User Procedures (optional) 
• Custom TCL scripts (macros) created by the user 
• Performs additional operations on models during the batch run 
• Pre Run and Post Run options can specify procedures performed before or 

after the run 
• Can specify when the procedure should be performed during the run  

• Pre-geometry load – as soon as batch mesher is invoked 
• Pre-batch mesh – just before loaded geometry is meshed 
• Post-batch mesh – after meshing is finished 
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3. Set up the Batch Mesh job  
• Specify a directory where geometry files are located 
• Select geometry files from the directory 
• Select a configuration to use for the mesh type for each file 
• Specify any user procedures to be performed on each part 
• Specify a directory where the meshed files will be located 
• Run the batch mesh job  

4. Monitor the Run Status of the job 
• Use the Run Status tab to keep track of all your submitted jobs 
• Use Load Mesh to open a selected file in a new HyperMesh session to view 

the resulting mesh 
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Exercise: Batch Meshing a Shell Bracket

Step 1: Open Batch Mesher. 

  

1. Click Start, point to Programs, point to Altair HyperWorks 9.0, and click Batch 
Mesher. 

2. In the Input Model Directory field, click Open ( ) to browse to the appropriate 
directory.   
 

3. In the Output Directory, click Open ( ) to browse to the appropriate directory if 
different from the input model directory.  If desired, you may request the .hm files be 
returned to the input model directory. 

4. Click  select files, . 

5. For Type of Geometry, select the appropriate CAD data type.  For this exercise, we will 
use geometry already loaded into Hypermesh. 

A filter will help select applicable models for batch meshing to HyperMesh. 

6. Locate and select the following model files, (use the CTRL key to select multiple files): 
part1.hm, part2.hm and bm_housing.hm. 

7. Click select. 
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Step 2: Define a configuration for the batch mesh run. 
1. Click the Configurations tab.  (Note there are several common configurations already 

available)

 

2. Click Add Entry, . 

3. In the Mesh Type field, type a name for the mesh type. 

4. Select the Criteria File field, and click Find Criteria Param File, . 

5. Select the file bm_housing.criteria. 

6. Select the Parameter File field, and click Find Criteria Param File, . 

7. Select the file bm_housing.param. 

A new mesh type is now available for selection on the Run Setup tab. 

Step 3:  On the User Procedures tab, set up a simple script to perform a 
tetramesh on the housing. 

1. Click Add Entry, . 

2. Select the TCL File field, and click Find TCL File, . 

3. Select the file hm_housing.tcl. 

4. In the TCL Procedure field, select the procedure tet_all. 
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5. In the Name field enter tetmesh. 

A new post-batch meshing script is now available for selection on the Run Setup tab. 

 

Step 4: On the Run Setup tab, begin defining a configuration for the batch 
mesh run. 
1. In the Mesh Type field, select a predefined mesh type  for each of the parts as follows: 

• bm_housing.hm: use the mesh type you defined in Step 2. 

• part1.hm: use 8mm auto. 

• part2.hm:  use 8mm auto. 

2. From the Post-Mesh drop-down list for the housing, select the procedure tetmesh.  

This will run the tetramesher on all available shell elements after batch meshing. 
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3. Click Submit to initiate the run. 

 or 

Click Submit At to submit the job at a specified time. 

The application automatically switches to the Run Status tab. As the parts run, the 
status changes from Pending to Working to Done.  

4. Once the part is at the Working state, select the part and select Details.  

A detailed summary appears with the status of the model through its Batch Mesher 
steps, the overall failed elements, and quality index. 

5. Once the part is at the Done state, click Load Mesh to load the mesh into HyperMesh 
for model interrogation. 

6. Once all parts have been meshed, select Run Details to obtain an overall run status. 

Any file can be paused or canceled.  If the file is paused, it can be resumed immediately 
or at a specific time.  

Once the Batch Mesher session has been setup with file directories and mesh types, it 
can be saved as a config that can be loaded at a future time.  

It is also possible to load an entire set of models that has already been batch meshed in 
order to take advantage of the Load Mesh option in the Run Status tab. 

If you choose to make modifications to your criteria or parameter files, the run can be 
submitted again.  The new files will be placed in a separate sub-directory. 
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Step 5 (Optional): Edit the Criteria and Parameter Files. 
1. Go to the Configurations tab. 

2. Click Mesh Type. 

3. Click Edit File. 

The Criteria and Parameter Editor window appears. 

 
On the Criteria tab, you can set the target element size, element criteria, and the 
method that is used to calculate the values.  An advanced criteria option can be enabled 
to give more control over the intermediate QI values, but is usually not necessary in 
order to obtain a good quality mesh.  
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A timestep calculator is also available for explicit solver models.  If this option is 
selected, the overall minimum element size will be set by this option and will gray out at 
the top of the element checks. 

The Parameters tab sets all of the meshing control over various geometric features.   
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Chapter 4 

Solids and Hexas 
Section 1: Creating and Editing Solid Geometry 
HyperMesh has several functions that require the definition of a volume, such as creating 
tetrahedral and hexahedral meshes.  This can be done either with surfaces that enclose the 
volume, or with solid geometry entities.  Working with solids provides a couple of 
advantages over surfaces.  Selecting the volume for the function requires only a single click 
because solids represent the volume with a single entity, as opposed to surfaces.  Solids 
that are topologically connected to each other also allow the functions being used to 
recognize the connection.  Creating mesh in these cases allows the mesh in adjacent 
volumes to automatically have proper connectivity. 

In this section, you will learn: 

• What is solid geometry 

• What is topology 

• What does 3D topology look like 

Solids are geometric entities that define a three-dimensional volume. Geometric entities are 
defined as follows: 

• Point: 0 dimensional; has only x, y, and z coordinates 

• Line: 1-dimensional; has length, can be curved through 3-dimensional space 

• Surface: 2-dimensional; has an area 

• Solid: 3-dimensional, has a volume 
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Solid Geometry 
HyperMesh supports the same solid geometry that is created in popular CAD software.  
Solid geometry can be achieved through the importation of native CAD data or can be easily 
created from bounding surfaces using the Bounding Surfaces option from the Solids panel 
on the Geom page. 
 
Additionally HyperMesh has numerous solid geometry creating tools to assist in the 
manipulation of solids.  These can be found through the pull-down Menu 
Geometry>Create>Solid and include many options for creation of solids through  

• Dragging – Extrusion of solids on a linear path 
and  

• Spinning – Extrusion of solids on a circular path. 
 
HyperMesh also supports the creation of primitive solids through the 
Geometry>Create>Primitives Pull Down.  Supported primitives include: 
 

 
 

Solid Editing 
Tools for editing geometry: 

• Surfaces panel 
• Creates surfaces using various methods 
• Can be used to split a solid 

• Edges of the surface must be equivalenced to edges on the solid 
• Solid Edit panel 

• Trim with… – splits a solid into 2+ solids using: 
• Nodes 
• Lines 
• Planes 
• Surfaces 

• Merge – combine 2+ adjacent solids into a single solid entity 
• Detach – disconnects connected solids 
• Boolean – advanced trim & merge operations 

• Union (Solid A + Solid B) – same as merge  
• Intersection (Solid A x Solid B) – keeps overlapping portions of 2 

solids 
• Removal (Solid A – Solid B) – deletes the volume of one solid from 

another 
• Cut (Cut Solid A with Solid B) – trims one solid with another solid 



Chapter 4: Solids and Hexas 

HyperWorks 10.0  HyperMesh Introduction 139 
Proprietary Information of Altair Engineering, Inc. 

 
 

• keeps both solids, but they no longer overlap 
 
Solid Topology 
Topology governs the connectivity of solids and thus the connectivity of the elements 
created from them.  Similar to 2D topology, 3D topology is represented by colors as follows: 

 
 
3D Topology visualization can be controlled using the Visualization Browser 
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Solid Meshing 
To mesh solid geometry, the Solid Map panel is used. 
 

 
 
In particular, the one volume and multi solid sub panels.  These allow for the automatic 
creation of Hexa/Penta mesh on mappable shapes. 
 

 
 
Mappable Shapes 
To use the automatic Solid Map function the geometry must be split into mappable shapes.  
Mappable shapes are defined as 2 opposing faces (source and destination) and faces that 
directly connect the source and destination (along faces). 
 

 
 

While this example shows two faces that are of the same shape and directly oppose each 
other, that is not a requirement.  The source and destination can be of drastically different 
shape and contour and need not lie directly opposite each other. 
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Requirements and Tips 
• Shape must be a closed volume 
• Multiple source faces are allowed 
• Destination face must be a single face 
 

Requirements and Tips cont. 
• No edges are permitted that are perpendicular to the drag direction.  If they exist they 

must be suppressed. 
 

 
 
• When splitting solids into Mappable Shapes it is recommended to split the part into the 

fewest possible regions to save time and offer more control over the mesh size.  This 
often means splitting parts in ways that are not perpendicular to surfaces.  
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• Placing a 2D mesh onto a “Source” face of a mappable shape will allow control over the 
pattern of the resulting 3D mesh.   
 

 
 
Requirements and Tips cont. 

• When splitting solids into mappable regions, shared faces will guarantee 3D element 
connectivity across the split.  This connectivity will also assure that the mesh pattern 
is carried through the part as subsequent regions are meshed. 
 

 
 

• Mesh connectivity of properly split regions with shared faces is also guaranteed even 
when mesh directions of the individual regions are not the same.  NOTE: The mesh 
pattern on the “along” faces will always be quads. 
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Exercise: Creating and editing solid geometry 
This exercise uses the model file, solid_geom.hm. 

  

Step 1: Retrieve model file, solid_geom.hm 

Step 2: Create solid geometry from the bounding surfaces. 
1. From the Geom page, enter the solids panel. 

2. Verify that you are in the bounding surfs sub-panel. 

3. Verify that the auto select solid surfaces option is checked. 

4. Select one surface on the part. 

5. All of the surfaces should automatically be selected. 

6. Click create to create the solid. 

7. The message bar indicates that a solid has been created. The solids are identified by 
thicker lines than surfaces. 

8. Click return to return to the main menu. 

Step 3: Create a solid geometry cylinder using primitives. 
9. Go to the primitives panel in one of the following ways: 

• From the Geometry pull-down menu, point to Create, and click Primitives 

• From the Geom page, go to primitives 

10. Go to the cylinder/cone sub-panel. 

11. Toggle full cone to full cylinder 
12. Click bottom center, and select one of the temporary nodes (see following image). 
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13. The cursor automatically advances to the normal vector button. 

  
14. Select the remaining temporary node shown in the image. 

15. For base radius= enter 1.5. 

16. For height=  enter 25. 

17. Click create solid. 

A solid cylinder is created in the middle of the first solid that was created. 

18. Click return to return to the main menu. 

Step 4: Subtract the cylinder’s volume from the rest of the part. 
1. Enter the solid edit panel in one of the following ways: 

• From the Geometry pull-down menu, point to Edit, and click Solids 

• From the Geom page, go to solid edit 
2. Go to the boolean sub-panel. 

3. Verify that operation type: is set to simple (combine all). 
4. Set operation: to A-B (remove B from A). 
5. With the solids entity selector for A: active, select the original solid. 

Verify that the cursor advances to solids next to B:. 
6. Select the solid cylinder created in step 3. 

7. Click calculate. 

8. To confirm the material has been removed, click shaded, , and rotate the model to 
inspect the part. 



Chapter 4: Solids and Hexas 

HyperWorks 10.0  HyperMesh Introduction 145 
Proprietary Information of Altair Engineering, Inc. 

 
 

  

Step 5: Split the solid geometry using bounding lines. 
You should still be in the solid edit panel. 

1. Go to the trim with lines sub-panel. 

2. Under with bounding lines:, activate the solids entity selector, and click anywhere on 
the model to select it. 

3. Activate the lines entity selector and, in the Graphics area, select the lines shown in the 
following image. 

  
4. Click trim to trim the model. 

A plane was trimmed and indicate that two solids now intersect. 
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Step 6: Split the solid geometry using a cut line. 
You should still be in the solid edit panel, trim with lines sub-panel. 

1. Under with cut line:, activate the solids entity selector, and select the small, tetrahedral 
shaped solid created in step 5. 

  

2. On the toolbar, click User Views, . 

3. From the pop-up window, click restore1. 

4. Click drag a cut line. 

5. Pick two locations on screen such that they define the endpoints of a line that roughly 
divides the tetrahedral solid in half, as shown below. 
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6. Click the middle-mouse button to split the solid. 

7. Select the half of the original tetrahedral solid as shown in the following image. 

  
8. Use with cut line: to split the solid as shown in the following image. 
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9. Select the solid shown in the following image. 

  

10. Click the User Views icon, , and select restore2. 

11. Use with cut line: to split the solid as shown in the following image. 

  

Step 7: Merge solids together. 
You should still be in the solid edit panel. 

1. Go to the merge sub-panel. 

2. With the solids entity selector under to be merged: active, select the three solids 
shown in the following image. 
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3. Click merge to merge the solids. 

The resulting solids in the tetrahedral area should look like the following image. There 
should be two solid entities, with one of them being hexahedral in shape in the corner. 

  

Step 8: Split the solid geometry with a user-defined plane. 
You should still be in the solid edit panel. 

1. Go to the trim with plane/surf sub-panel. 

2. Click the User Views icon, , and click restore3. 

3. With the solids entity selector under with plane: active, select the large solid 
representing the majority of the part. 
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4. Set the plane selector to N1, N2, N3. 

5. With N1 active, press and hold the left mouse button, and move the mouse cursor over 
one of the two edges shown in the following image. 

The edge should highlight. 

  
6. Release the mouse button, and left-click in the middle of the edge. 

A green temp node appears at the location to indicate the selection for N1.The plane 
selector is advanced to the N2 selection. 

7. In the same manner, highlight the other line shown in the image and select two nodes 
along its length. 

Your selection should look similar to the following image. 
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8. Click trim to trim the solid. 

  

Step 9: Split the solid geometry with a swept line. 
You should still be in the solid edit panel. 

1. Go to the trim with lines sub-panel. 

2. With the solids entity selector under with sweep lines: active, select the solid with the 
cylinder removed. 
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3. Activate the line list entity selector and select the edges shown below.  

 

  
4. Under sweep to:, switch the plane selector from N1, N2, N3 to x-axis. 

5. Verify the panel is set to sweep all below the plane selector. 

6. Click trim to trim the solid. 

Step 10: Split the solid geometry with a principal plane. 
You should still be in the solid edit panel. 

1. Go to the trim with plane/surf sub-panel. 

2. With the solids entity selector under with plane: active, select the solid with the cylinder 
removed. 

3. Switch the plane selector from N1, N2, N3 to z-axis. 

4. Press and hold the left mouse button, and move the mouse cursor over the edge shown 
in the following image. 

The edge should highlight. 
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5. Release the mouse button, and left-click anywhere along the edge. 

6. A purple temp node appears at the location to indicate the selection for the base node. 

7. Click trim to trim the solid. 

8. Click return to return to the main menu. 

Step 11: Split the solid geometry by creating surfaces inside the solids. 
1. Enter the surfaces panel in one of the following ways: 

• From the Geometry pull-down menu, point to Create, and click Surfaces 

• From the Geom page, go to surfaces 

2. Go to the spline/filler sub-panel. 

3. Deactivate auto create (free edge only) and keep tangency options. 

4. Select the five lines shown in the following image: 
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5. Click create to create the surface. 

6. Click return to return to the main menu. 

7. From the Geom page, enter the solid edit panel.  

8. Go to the trim with plane/surf sub-panel.  

9. Under with surfs:, with the solid entity selector active, select the solid in the Graphics 
area.  

10. Under with surfs:, with the surfs entity selector active, select the surface in the 
Graphics area that was just created. 

11. Click trim. 

12. Click return. 

13. From the Geom page, go to the surfaces panel. 

14. Go to the spline/filler sub-panel. 

15. Select the four lines shown in the following image. 

  
16. Click create. 

17. Click return. 

18. Go to the solid edit panel in one of the following ways: 

• From the Geometry pull-down menu, point to Edit, and click Solids 

• From the Geom page, go to solid edit 
19. Select the trim with plane/surf sub-panel. 

20. Under with surfs: activate solids and click the solid in the Graphics area. 

21. Under with surfs:, with the surfs entity selector active, select the surface in the 
Graphics area that was just created. 

22. Uncheck the Extend Trimmer box.  
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23. Click trim. 

24. Click return to return to the main menu. 

Step 12: Suppress extraneous edges on the part. 
1. Enter the edge edit panel. 

2. Go to the (un)suppress sub-panel. 

3. Select lines >> by geoms. 

4. With the solids entity selector active, select the four solids shown in the image below. 

  
5. Click add to selection. 

6. Set breakangle = to 45. 

7. Click suppress to suppress the edges. 

8. Click return to return to the main menu. 

 

 
Hex-meshing the split Solid Geometry 

Step 13: While you can use the model you created in the previous exercise, it 
is recommended you retrieve model file, solid_map.hm.  

Step 14: Mesh the 1/8th sphere-shaped region. 

1. On the toolbar, click Shaded Geometry & Surfaces ( ). 

2. Enter the solid map panel. 



Chapter 4: Solids and Hexas 

156 HyperMesh Introduction   HyperWorks 10.0 
Proprietary Information of Altair Engineering, Inc 

 
 

• From the Mesh pull-down menu, point to Create, and click Solid Map Mesh 

• From the 3D page, go to solid map 

3. Go to the one volume sub-panel. 

4. Under along parameters:, set elem size= to 1. 

5. With the solid entity selector under volume to mesh active, select the small cube-
shaped solid, as shown in the following image. 

 
6. Click mesh. 

7. On the toolbar, click Shaded Elements & Meshlines icon ( ). 

8. Select the solid indicated in the following image. 



Chapter 4: Solids and Hexas 

HyperWorks 10.0  HyperMesh Introduction 157 
Proprietary Information of Altair Engineering, Inc. 

 
 

 
9. Click mesh. 

10. Click return to return to the main menu. 

Step 15: Create a shell mesh with the automesh panel to control a mesh 
pattern. 
1. Go to the 2D page. 

2. Enter the automesh panel in one of the following ways: 

• From the Mesh pull-down menu, select Create, and click 2-D AutoMesh 

• Press F12 

3. Select the surface indicated in the following image. 
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4. Verify that the meshing method is set to size and bias and interactive. 

5. Verify that element size = is set to 1.000. 

6. Verify that mesh type: is set to mixed. 

7. Click mesh. 

8. In the elem density = field, enter 4. 

9. Click set all to. 

All the densities are set to 4. 

10. Click mesh. 

11. Click return to return to the main menu. 

Step 16: Mesh the solid volume on which the surface mesh was created in 
step 15. 
1. Go to the 3D page. 

2. Enter the solid map panel. 

3. Go to the one volume sub-panel. 

4. Select the volume shown in the following image. 
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5. Under along parameters:, toggle elem size= to density= and enter 10. 

6. Click mesh. 

7. On the toolbar, click the Wireframe Geometry icon ( ). 

8. Rotate the part and note how the mesh pattern created with the automesh panel has 
been used for the solid elements. 
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Step 17: Mesh the remaining solid volumes. 
You should still be in the solid map panel. 

1. Select one of the remaining unmeshed solid volumes. 

Make sure to select a solid adjacent to one that has already been meshed so that 
connectivity is maintained. 

2. Switch source type: to mixed. 

3. Under along parameters:, toggle density= to elem size= and enter 1.5. 

4. Click mesh. 

5. Repeat until all solid volumes are meshed. 

6. Click return to return to the main menu. 

Step 18 (Optional): Save your work. 
With this section of the exercise completed, you can save the model if desired. 

Automated Solid Map Meshing 
The capability to automate the solid map meshing process is now available. Using the 
“Mappable” visualization mode in conjunction with the multi-solids feature will inform you that 
the solid(s) are ready for solid meshing. Using the multi-solids feature will allow for all solids 
within the model to be meshed in one step provided that they are mappable. 

In this section of the tutorial we will delete all the elements from the previous section, use 
the Mappable visualization mode and solid mesh the part using multi-solids. 

Step 19: Delete the elements within the model. 
1. Press F2 to access the delete panel.  

2. Select all the elements. 

3. Click delete. 

4. Click return to return to the main menu. 

Step 20: Use the Mappable visualization mode. 

1. On the toolbar, click Shaded Geometry & Surfaces ( ). 

2. From the geometry visualization pull-down, select Mappable ( ). 

You will notice that each solid is color coded, the color of the solid represents its 
mappable state. The goal is to ensure that each solid is either 1-directional or 3-
directional mappable. 

The color of the mappable state can be found (and adjusted if necessary) within the 
Options>>Color panel. 
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By mappable display control (solids) 

• ignored map Default visualization for solids that require partitioning to 
become mappable. 

• not mappable Visualization for solids that have been edited, but still require 
further partitioning to create mappable solids. 

• 1 dir. map Visualization for solids that can be mapped (for 3-D meshing) 
in one direction. 

• 3 dir. map Visualization for solids that can be mapped (for 3-D meshing) 
in three directions. 

Once in the mappable visualization mode it is clear that there is one 3-directional 
mappable solid, the rest are 1-directional mappable. 

 

Step 21: Use the Multi-solid feature to mesh the part. 
1. From the main menu, go to the 3D page. 

2. Enter the solid map panel. 
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3. Go to the multi solids sub-panel. 

4. Select solids>>all. 
5. Under source shell type, select mixed.  
6. Set elem size to 1. 

7. Click Mesh. 

The solids will be sequentially solid meshed. Once complete inspect the model and note 
that all the mesh within the solids is correctly equivalenced.  

 

Step 22 (Optional): Save your work. 
With this exercise completed, you can save the model if desired. 
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Chapter 5 

Tetra Meshing 
HyperMesh provides several methods of generating a tetrahedral mesh.  The standard 
method creates tetras from an enclosed volume of shell elements, plus several parameters.  
This provides the user with a lot of control over the final tetra mesh.  The volume tetra 
mesher quickly and automatically creates a tetrahedral mesh on an enclosed volume of 
surfaces or solid geometry with only a few inputs.   Finally, the quick tetra mesher creates a 
tetra mesh that maintains user specified quality requirements, but may sacrifice details in the 
shape of the part to do so.   All methods are valid in certain situations.  The exercise in this 
section focuses on the standard and volume tetra meshing methods. 

In this chapter, you will learn about: 

• Volume tetra mesher 

• Standard tetra mesher 

• Checking tetra element quality 

• Re-meshing tetra elements 
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Standard Tetra Meshing 
Standard Tet Meshing involves wrapping a volume in 2D elements and then using that 
predefined mesh to “grow” Tetra elements to fill the volume.  The process is as follows; 

1. Generate a surface mesh of shell elements 
2. Check quality and connectivity of the plate elements 
3. Generate the tetrahedral mesh 
4. Delete the original  surface mesh 
5. Edit if necessary to obtain good quality 

 
The standard method of Tetra Meshing can be found through the Mesh>Create>Tetramesh 
Pull down and then select the tetra mesh subpanel. 

• Requirements for the shell mesh: 
• Enclose one, and only one, continuous volume 
• There can be no free or T-connected edges. 
• There can be no duplicates in the mesh. 
• Elements should not fold over and overlap each other 
• Avoid very low minimum tria angles 
• Avoid a large difference in size between adjacent elements 
• Avoid a large difference is size between two sides of a wall thickness 

• For quad elements in the shell mesh: 
• Split quads into 2 trias and create tetra elements under them 

– OR – 
• Keep the quad element and create pyramids under them 

 
When using the Standard Tetramesh, the user will select the trias/quads that will define the 
mesh and optionally the user can select fixed trias/quads. HyperMesh will, when creating 
the tetra mesh, flip the diagonal of the 2D elements if it deems the resulting tetra mesh will 
be of a higher quality with the flip.  HyperMesh will not do this to elements selected in the 
fixed selection.   

• Standard Trias/Quads 
• Adjacent tria faces on the tetrahedral mesh may have their diagonal reversed 

from the shell mesh if tetras are better quality 

 
• Fixed Trias/Quads: 

• Adjacent tria faces on the tetrahedral mesh always match the shell mesh 
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Volume Tetra Meshing 
The volume tetra meshing utility, found in the Mesh>Create>Tetramesh Pull down and in the 
volume tetra subpanel, provides a quick method for generating tetra mesh.  No initial 2D 
mesh is required and the tetra mesh can be generated on solid geometry or inside surfaces 
fully bounding a volume. 

 
 
Two options are available to control the mesh; 

• Use Proximity – Creates smaller elements next to small features to make a smooth 
transition from small to large elements. 

• Use Curvature – Will place more elements along curved surfaces based on user 
specified settings. 

  
 
TetraMesh Process Manager 
The final, and most powerful method for creating a 
tetra mesh is the TetraMesh Process manager 
found in the Mesh>Create>TetMesh>Create New 
Pull down.  This uses the incorporated process 
manager to provide a step by step process to guide 
the user through import, cleanup and organization 
of the geometry, establishment of individual mesh 
pattern, and creation and cleanup of the tetra mesh.    
 
The user can control organization, mesh style and 
ultimate mesh quality.  More information can be 
found in the online help and tutorials.
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Exercise: Tetramesh a Housing 

Step 1:  Retrieve and view the model file. 
The model for this exercise is housing.hm.  Take a few moments to observe the model 
using the different visual options available in HyperMesh (rotation, zooming, etc.). 

Only the geometry in the component cover is currently displayed. The file contains two parts 
defined by a volume of surfaces. The geometry has been cleaned such that surface 
connectivity is proper and surface edges that would cause sliver elements are suppressed. 

Step 2:  Use the volume tetra mesher and equilateral triangles to create a tetra 
mesh for the cover. 
1. Access the tetramesh feature in one of the following ways: 

• From the Mesh menu, point to Create, and click Tetra Mesh 

• On the 3D page, click the tetramesh sub-panel 

2. Go to the volume tetra sub-panel. 

3. Set the entity selector to surfs and select one of the surfaces in the model. 

The connected surfaces are selected automatically. 

4. Verify that 2D: is set to trias and 3D: is set to tetras. 

These control the type of element that will be created for the surface mesh and solid 
mesh of the part. 

5. Verify that the use curvature and use proximity options are off.  

6. For element size=  specify 10. 

7. Click mesh to create the tetra mesh. 

8. From the toolbar, click the shaded elements icon, .   

9. Take a moment to inspect the mesh pattern that the volume tetra mesher created. 
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Tetra mesh from the volume tetra sub-panel and equilateral triangles (2D: trias)  

10.  Click reject to reject the mesh. 

The mesh is deleted. 

Step 3:  Use the volume tetra mesher and right triangles to create a tetra mesh 
for the cover. 
You should still be in the tetramesh / volume tetra sub-panel. 

1. Select one of the surfaces in the model. 

2. Switch 2D: to R-trias. 

3. Click mesh to create the tetra mesh. 

4. Inspect the mesh pattern that the volume tetra mesher created. 

5. Compare it to the first mesh you created and note the differences. The 2D: R-trias 
setting tends to create tetra elements with triangular faces that are right triangles (90-45-
45 angles) while the 2D: trias setting tends to create equilateral triangles (60-60-60 
angles). 
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Tetra mesh from the volume tetra sub-panel and right triangles (2D: R-trias)  

6. Reject the mesh. 

Step 4:  Use the volume tetra mesher to create a tetra mesh with more 
elements along curved surfaces. 
You should still be in the volume tetra sub-panel. 

1. Select one of the surfaces in the model. 

2. Activate the option, use curvature. 

Additional parameters appear. The option, use curvature, causes more elements to be 
created along areas of high surface curvature. Thus, curved areas such as fillets will 
have more and smaller elements, which capture those features with higher resolution. 

3. Verify that elem feature ang =  is set to 30. 

4. For min element size = specify 1.0. 

5. Click mesh to create the tetra mesh. 

6. Shade the tetrahedral elements. 

7. Inspect the mesh pattern that the volume tetra mesher created. 

8. Compare it to the previous meshes you created and note the differences. More elements 
are created around the fillets. 
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Tetra mesh from the volume tetra sub-panel and the option use curvature active  

9. Click reject to reject the mesh. 

Step 5:  Use the volume tetra mesher to create a tetra mesh with more 
elements around small features. 
You should still be in the volume tetra sub-panel. 

1. Select one of the surfaces in the model. 

2. Activate the use proximity option. 

The use proximity option causes the mesh to be refined in areas where surfaces are 
smaller. The result is a nice transition from small elements on small surfaces to larger 
elements on larger, adjacent surfaces.  

3. Click mesh to create the tetra mesh. 

4. Shade the elements. 

5. Inspect the mesh pattern that the volume tetra mesher created. Compare it to the 
previous meshes you created and note the differences. More elements were created 
around surfaces with small angles as indicated in the following image. 
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Tetra mesh from the volume tetra sub-panel with options, use curvature and use proximity  

6. Click return to exit to the main menu. 

Step 6:  Prepare the display to tetra mesh the hub component using the 
standard tetra mesher. 
1. Use the model browser to turn off the display for all components for geometry. 

2. Turn on the display of the geometry for the hub component. 

3. Use the model browser to turn off the display for all components for elements. 

4. Turn on the display for the hub and tetras components for elements. 

There are tria shell elements in the hub component. Currently, there are no elements in 
the tetras component.  

Step 7 (Optional):  Review the connectivity and quality of the tria mesh to 
validate its integrity for the standard tetra mesher. 
Use the edges and check elems panels to make sure that there are no free edges or very 
small angles in the tria shell mesh. 

1. Access the edges panel in one of the following ways:  

• From the Pull-down menu, select Mesh, then Check, then Components, then 
Edges 

• From the main menu, select the Tool page and the edges panel. 
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2. With the comps selector active, pick any tria element on the hub component. 

3. Click find edges. 

A message in the header bar should state, "No edges found. Selected elements may 
enclose a volume." 

This is desired as the tetra mesher requires a closed volume of shell elements. 

4. Click return to exit to the main menu. 

5. Access the check elements panel in one of the following ways: 

• From the Pull-down menu, select Mesh, then Check, then Elements, then Check 
Elements 

• From the main menu, select the Tool page and the check elems panel. 

6. Verify that you are in the 2-d sub-panel.  

7. Identify elements having an aspect ratio greater than 5. 

Aspect ratio is the ratio of the longest edge of an element to its shortest edge. This 
check helps you to identify sliver elements.  

All of the hub’s shell elements pass the check; all of the elements have an aspect ratio 
less than 5.  

8. Identify tria elements having an angle less than 20. (trias: min angle) 

This check also helps you to identify sliver elements.  

All the hub’s shell elements pass the check; all the elements have angles greater than 
20. 

The surface mesh is suitable for creating a tetra mesh. 

9. Click return to exit to the main menu. 

Step 8:  Create a tetra mesh for the hub using the standard tetra mesher. 
1. Use the model browser to set the current component to tetras. 
2. On the 3D page, go to the tetramesh panel. 

3. Access the tetra mesh sub-panel. 

4. With the comps selector active under select trias/quads to tetra mesh:, select one of 
the hub shell elements from the Graphics area. 

5. Elements or comps selected here give the tetra mesher the option to swap the diagonal 
for any pair of surface trias, if that will result in a better tetra mesh quality. If you do not 
want to change the element connectivity on the surface mesh, use the fixed trias/quads 
selector. 

6. Click mesh to generate the tetrahedral elements. 
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Cut-away view of tetrahedral elements  

Step 9:  Check the quality of the hub’s tetra elements. 
1. Use the model browser to display only the elements in the tetras component. 

2. Access the check elems panel. 

3. Go to the 3-d sub-panel. 

4. Identify the smallest element length among the displayed elements. 

If the minimum length is acceptable for a target element size of 5.0, then no further 
action is necessary. 

5. Identify the smallest angle (tria faces: min angle) among the displayed elements.   

If the minimum tria face angle is no less than 10°, then the mesh quality should be 
acceptable. 

6. Identify elements having a tet collapse smaller than 0.3. 

The tet collapse criteria is a normalized volume check for tetrahedral elements. A value 
of one indicates a perfectly formed element with maximum possible volume. A value of 
zero indicates a completely collapsed element with no volume.  

The message bar indicates that one element has a tetra collapse smaller than 0.3.  
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Step 10:  Isolate the element with the tetra collapse smaller than 0.3 and find 
the elements surrounding it. 
You should still be in the check elements panel. 

1. With 0.3 still specified for tet collapse, click tet collapse again. 

2. Click save failed. 

The element that failed the tetra collapse check is saved in the user mark, and can be 
retrieved in any panel using the extended selection menu. 

3. Click return to exit to the main menu. 

4. Access the mask panel in one of the following ways: 

• From the display toolbar, select Mask ( ). 

• Press F5 on your keyboard. 

5. Set the entity selector to elems and select elems >> retrieve. 

The element that was saved in the check elems panel is retrieved. 

6. Select elems >> reverse. 

7. Mask the elements. 

Only the one tetra element that failed the tetra collapse check should be displayed. 

8. Click return to exit to the main menu. 

9. On the display toolbar, click unmask adjacent ( ).  

The layer of elements that is attached to the one displayed element is identified and 
displayed.  

10. Click unmask adjacent ( ) two more times.  

The layer of elements that is attached to the displayed elements is identified and 
displayed. The functionality of unmask adjacent can be duplicated using the find panel, 
find attached sub-panel on the Tool page.   

Step 11:  Remesh the hub’s displayed tetra elements to improve their tetra 
collapse. 
1. Access the tetramesh panel. 

2. Go to the tetra remesh sub-panel. 

3. Select elems >> displayed. 

4. Click remesh to regenerate this area of the mesh. 

Note that the re-meshing operation works on only one group of elements (one volume) 
at a time.  

5. Click return to exit to the main menu. 
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6. Access the check elems panel. 

7. Click tet collapse to find out if the tetra collapse has improved for the displayed 
elements. 

The message in the header bar should indicate that the minimum tetra collapse is larger 
than the value reported before the tetra elements were re-meshed.  

8. Click return to exit to the main menu. 

Step 12 (Optional):  Save your work. 
Now that the tetra mesh is complete, it is a good time to save the model. 

Summary 
A tetra mesh has been created for both parts in the file.  Different procedures for tetra 
meshing were used.  Either method can be used to mesh parts, depending on the needs of 
the analysis.  Also, the tetra re-mesh function was used to show how to quickly fix the quality 
of tetra elements. 
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Chapter 6 

Analysis Setup 
Section 1: Setting up Loading Conditions 
A finite element solver can solve for responses of parts to loading conditions placed on 
them. The loads can be in the form of any combination of boundary constraints, forces, 
pressures, temperatures, etc.  This section focuses on defining the loading conditions on a 
model. 

In this section, you will learn how to: 

• Create constraints (RADIOSS SPC) on the channel’s geometry lines  

• Create a force (RADIOSS FORCE) on the bracket to simulate a pressing load on it 

• Define a load step (RADIOSS SUBCASE) 
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Analysis Setup 
Analysis setup is the definition of all information for an analysis besides the mesh including: 

• Specification of the solver to be used 
• Creation materials, properties, etc. 
• Assignment of a solver specific format to HyperMesh entities 
• Creation boundary conditions (constraints, loads, contacts, etc.) 
• Definition of other required information (solution requests, general run 

parameters, etc.) 
This section will focus on the creation of boundary 
conditions 
 
Supported Entities 

• FE Loading 
• Loads (constraint, force, pressure, moment, 

temperature, flux, velocity, acceleration) 
• Equations (mathematical link between 

nodes) 
• Contacts 
• Group (defines contact between entities) 
• Contact Surfs (defines a list of entities that can be 

used as master or slave in a group) 
• Reference Entities 

• Sets (a simple list of a particular type of entity) 
• Blocks (a list of entities contained within a box 

shape) 
• Coordinate Entities 

• Systems (coordinate axes) 
• Vectors 

• Plotting 
• Curves (X-Y data) 
• Plots (a display of curves with axes) 

• Output Requests 
• Loadsteps (combinations of load collectors) 
• Output Blocks (request output from an analysis for 

certain entities) 
• Control cards (job-level, global parameters for the analysis)  
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Loads on Geometry 
HyperMesh allows the user to place loads on geometry before the mesh is ever created.  
Then using the BCs>Loads on Geometry pull down, those loads will be mapped to the 
elements that were created from that geometry.  This is a time saving advantage as the user 
only needs to pick  one, or at most a few, geometric entities to ultimately create hundreds or 
even thousands of loads or constraints.  
 
To use this, change the entity selector from a node or element selection to a geometric 
selection such as surfs or lines. 
 
Then after the part is meshed, using 
the Loads on Geometry function, 
the loads will be automatically 
mapped  
to elements created from that 
geometry. 
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Exercise: Setting up Loading Conditions 
This exercise uses the model file, channel_brkt_assem_loading.hm. It contains the 
bracket and channel assembly in the following image. 

 

Step 1:  Retrieve and view the HyperMesh model file and set profile.  

1.   Load the model channel_brkt_assem_loading.hm. 

2.   Set the user profile to Radioss Bulk Data 

Step 2:  Create two load collectors named pressing_load and constraints.  

1. Access the collectors panel by clicking load collectors ( ) on the collectors toolbar. 

2. Go to the create sub-panel. 

3. For loadcol name = enter pressing_load. 

4. Select your desired color. 

5. Switch the creation method to no card image. 

6. Create the load collector pressing_load. 

7. For loadcol name = enter constraints. 

8. Select your desired color. 

9. Create the load collector constraints. 

10. Return to the main menu. 

Step 3:  Apply constraints (RADIOSS SPC) to the channel’s line geometry. 
1. Use the model browser to display the geom ( ) for the component channel. 
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2. On the toolbar, click User Views (  ), and pick iso1. 

3. Enter the constraints panel in one of the following ways: 

• From the Pull-down menu, select BCs, then Create, then Constraints 

• On the main menu, select the Analysis page, then select constraints  

4. Go to the create sub-panel. 

5. Switch the entity selector to lines. 

6. Select the six lines on the perimeter of the channel’s bottom surface as shown in the 
following image.   

 
7. Activate degrees of freedom (dof) 1 through 6. 

For a RADIOSS linear static analysis, dof 1, 2, and 3 represent translations in the global 
x, y, and z directions respectively. Dof 4, 5, and 6 represent rotations about the global x, 
y and z axis, respectively. 

8. Set Load Types = to SPC. 

9. Create the constraints on the lines. 

10. For size = enter 5. 

The display size of the constraints is reduced. 

11. Activate the option label constraints. 

A label is displayed for each constraint. The labels identify which dofs are assigned to 
the constraints. 

12. Click return to exit to the main menu. 
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Step 4:  Map the constraints (RADIOSS SPC) on the geometry lines to the 
channel nodes associated to the lines. 
1. Access the load on geom panel in one of the following ways: 

• From the Pull-down menu, select BCs, then load on geom 

• On the main menu, select the Analysis page, then select Load on Geometry 

2. Select loadcols >> constraints. 

3. Click select to complete the selection of load collectors. 

4. Click map loads. 

A constraint is at each node associated to the geometry lines.  

5. Click return to exit to the main menu. 

6. On the model browser, turn off the display of geometry for all component collectors. 

Step 5:  Prepare to create forces (RADIOSS FORCE) on the bracket for the 
pressing load case. 

1. On the toolbar, click User Views ( ) and pick restore1. 

2. On the model browser, right-click on the pressing_load load collector and select Make 
Current. 
The pressing_load load collector is now the current load collector, and any loads created 
will be placed in this collector. 

Step 6:  Create two forces (RADIOSS FORCE) on the bracket for the pressing 
load case.   
1. Access the forces panel in one of the following ways: 

• From the Pull-down menu, select BCs, then forces 

• On the main menu, select the Analysis page, then select Forces 

2. Go to the create sub-panel. 

3. With the nodes selector active, select the two nodes as indicated in the following image. 
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4. For magnitude = enter 5.  

5. Switch the direction selector from N1, N2, N3 to y-axis. 

6. Set Load Types = to Force. 

7. Create the forces. 

8. For magnitude % = specify 200.0. 

The display size of the force is increased. 

9. Activate the option label loads. 

Each force displays the label FORCE = 5.00e+00. 

 
The two forces created for the pressing load case 
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10. Click return to exit to the main menu. 

Step 7:  Define the load step for the pressing load case.   
1. Access the load step panel in one of the following ways: 

• From the Pull-down menu, select Setup, then Create, then Load Steps 

• On the main menu, select the Analysis page, then select load steps 

2. For name = enter pressing_step. 

3. Activate the SPC and LOAD options. 

4. Click the = next to SPC. 

5. Switch name to name(id). 
This shows the names of the load collectors with their ID numbers in parenthesis. 

6. Select the constraints load collector. 

Note that the field next to the = now has a value of 2, which is the ID of the constraints 
load collector. 

7. Click the = next to LOAD and select the pressing_load load collector. 

8. Set the type: to linear static. 

9. Create the load step pressing_step. 

 In the status bar appears the message "The load step has been created."  Nothing new 
is displayed in the graphics area. 

10. Click return to exit to the main menu. 

Step 8:  Display the load step on and off (the load collectors defined in the 
load step). 
1. On the model browser, turn the display of the load step pressing_step off. 

2. Notice the load collector’s constraints and pressing_load are no longer displayed. 

3. Turn the display of the load step pressing_step back on. 

4. Click return to exit to the main menu. 
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Section 2: Formatting Models for Analysis 
The purpose for using a finite element (FE) pre-processor is to create a model that can be 
run by a solver.  HyperMesh interfaces with many FE solvers and all of them have unique 
input file formats. HyperMesh has a unique template(s) for each solver it supports. A 
template contains solver specific formatting instructions, which HyperMesh uses to create an 
input file for that solver. 

This exercise gives you an understanding of the basic concepts for creating a solver input 
file by using a template. More specifically, you will learn how to review entities in HyperMesh 
to see how they will appear in the solver input file, define materials and properties and select 
solver element types for HyperMesh element configurations. 

In this section, you will learn how to: 

• Create a solver input file by using a template 

• Review entities in HyperMesh to see how they will appear in the solver input file 

• Define materials and properties 

• Select solver element types for HyperMesh element configurations 
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Interacting with Solvers 

 

 



Chapter 6: Analysis Setup 

HyperWorks 10.0  HyperMesh Introduction 185 
Proprietary Information of Altair Engineering, Inc. 

 

 

Tools 
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Process 

1. Create Materials and enter values into them 

2. Use the model browser or material collector icon.  
Create Properties and enter values into them.  Material collectors can be associated 
with properties during creation. 

Use the model browser or property collector icon.  
 

3. Create component collectors and organize entities into them.  Property collectors can 
be associated with components during creation or properties can be assigned 
directly to elements. 

4. Use the model browser or component collector icon.  
5. Mesh and load the model 
6. Create solver specific cards and controls. 

 
 
While it is not required that events follow these steps in order, if you follow these 
steps then there is no need to go back to update or assign information to collectors 
as the required information will already be in place. 
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Exercise: RADIOSS Linear Statics Setup for a Shell Assembly 
This exercise uses the file channel_brkt_assem_Analysis.hm. It contains the bracket 
and channel assembly in the following image.  

  

Step 1: Retrieve and view the file, channel_brkt_assem_Analysis.hm. 

Step 2: Load the RADIOSS (Bulk Data) template by loading RADIOSS (Bulk 
Data) user profile. 
1. From the Preferences menu, click User Profiles…  

2. Select the RADIOSS (Bulk Data) user profile and click OK to close the dialog. 

Step 3: Review a bracket element to identify what type of RADIOSS element it 
is and to see how it will be formatted in the RADIOSS input file. 
1. Access the card editor panel by going to the collectors toolbar and selecting card edit 

( ). 

2. Switch the entity selector to elems. 

3. In the graphics area, select an element of the (blue) bracket. 

4. Click edit. 
The card image for the element appears above the panel menu area. It indicates the 
element is a RADIOSS CQUAD4 or CTRIA3, depending on whether you selected a 
quad or tria element. EID is the element’s ID. PID is the ID of the element’s property. 
G(X) is the grid (node) ID that makes up the element. 

Options specific to the CQUAD4 or CTRIA3 appear in the menu panel area. 
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5. Return to the card panel. 

Step 4:  Review and edit the existing steel material’s card image by accessing 
the card editor from the model browser. 
This material is defined for the channel.  

1. In the model browser, open the materials branch of the browser list to show the material 
steel. 

2. Right-click steel and select Card Edit…. 

The card image for the material appears. It indicates the material is of RADIOSS Bulk 
Data type MAT1.  

3. Under Poisson’s Ratio [NU], change the value from 0.3 to 0.28. 

4. Return to the main menu to accept the change. 

Step 5:  Define a material collector named aluminum for the bracket.  
1. Right-click in the white space of the browser list. 

2. Select Create >> Material. 
The Create Material popup dialog appears. 

3. For Name: enter aluminum. 

4. Set Card image: to MAT1. 

5. Click Create/Edit to create the material and edit it.  

The card image for the new material appears.  

6. Click [E] and enter 7.0e4 in the field that appears. 

This is Young’s Modulus. 

7. Click [NU] and enter 0.33 in the field that appears. 

This is Poisson's Ratio. 

8. Click return to exit the panel.  

Step 6: Define a Property collector (PSHELL card image) that will  be assigned 
to the Channel component collector. 

1. On the collectors toolbar, go to the Property Collector panel ( ). 

2. Go to the create sub-panel. 

3. For name= enter channel. 

4. Click the type= button and select 2D. 

5. Click the card image= button and pick PSHELL. 

6. Click the material= button and select the Steel material collector. 

7. Click the green create/edit button (This will open the card editor panel). 
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8. Click [T] and enter 3.0 into the field that appears. (This will assign a 3.0 unit thickness). 

9. Return to the main menu. 

Step 7: Assign the channel property to the channel component. 

1. On the collectors toolbar, go to the Components panel ( ). 

2. Go to the assign sub-panel. 

3. Select comps >> channel. 
4. Click select to complete the selection. 

5. For property= select channel. 
6. Click assign. 

7. Click return to exit the panel. 

Step 8:  Update the bracket property to have a PSHELL card image, a 
thickness of 2.0, and the aluminum material. 
1. Access the properties panel in one of the following ways: 

• From the Pull-down menu, select Properties, then Create. 

• From the Collectors toolbar, select properties ( ). 

2. Go to the update sub-panel. 

3. Select props >> bracket. (Click props to select from the component list.) 

4. Click select to complete the selection. 

5. For card image = select PSHELL. 

6. For material = select aluminum. (Click the text field to select from the material list.) 

7. Click update/edit to load and edit the card image and assign the material. 

8. Notice the material ID MID is 2, which is the ID of the aluminum material you created 
earlier and assigned to the bracket component. 

9. For the thickness [T] enter 2.0. 

10. Return to the properties panel.  

11. Return to the main menu. 

Step 9:  Calculate the section properties for the bar elements (RADIOSS 
CBEAM) by using HyperBeam.  
1. On the 1D page, enter the HyperBeam panel. 

2. Go to the standard section sub-panel. 

3. Switch the standard section type: to solid circle. 
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4. Click create to invoke the HyperBeam module. 

The HyperBeam module appears and the HyperMesh session is not visible. (HyperMesh 
is visible again upon exiting HyperBeam.)  

The solid, red circle represents the cross section. Under the local coordinate system you 
should see the number, 10.0000, which is the circle’s diameter. 

 
HyperBeam module with the standard solid circle section 

5. Click on the number 10.0000 to activate a number entry field, enter 6, and then press 
ENTER. 

In the section property display area, the values are automatically updated to reflect the 
circle’s new diameter. 

6. In the model tree area, click on the section’s name, auto_standardsection_1.  

After a brief moment, the name becomes an editable text entry field. 

7. Rename the section to 6mm_Beam_Sect. 
8. From the File pull-down menu, select Exit. 
9. Answer Yes to the question "save data?". 

10. Return to the main menu. 

Step 10:  Create a property collector named bars_prop for the bar elements 
(RADIOSS Bulk Data). 
1. Create a new property collector by: 

• Using the properties: create sub-panel 

• Right-clicking in the model browser 



Chapter 6: Analysis Setup 

HyperWorks 10.0  HyperMesh Introduction 191 
Proprietary Information of Altair Engineering, Inc. 

 

 

2. Enter the name bars_prop.  

3. Specify the card image. 

• For the properties panel, set type= to 1D and switch card image= to PBEAM. 

• For the Create Properties dialog, set Card Image: to PBEAM. 

4. Set the material to steel. 
5. Click create/edit to create the property and edit it. 

6. At the top of the card image, select beamsec >> 6mm_Beam_Sect. 
The parameter fields in the PBEAM card are automatically populated by the data in the 
beam section 6mm_Beam_Sect.  

7. Return to the main menu.  

Step 11:  Update the CBEAM element to use the PBEAM Property.   
1. Access the Properties: assign sub-panel. 

2. Select elems>>by collector and pick the bolts component collector. 

3. Click the green select button. 

4. Set type= to 1D. 

5. Click the property=  button and select the bars_prop property collector. 

6. Click the green assign button. 

7. Return to exit the panel. 

Step 12:  Define a H3D file to be output from RADIOSS by using the control 
cards panel. 
1. Access the control cards panel in one of the following ways: 

• From the Pull-down menu, select Setup, then Create, then Control Cards 

• On the main menu, select the Analysis page, then select control cards 

2. Select the control card FORMAT. 

You may need to click next to get to the second page of cards. 

Notice in the card image the one FORMAT line is set to H3D. This specifies RADIOSS to 
output results to a Hyper3D (H3D) file, which can be viewed in HyperView Player. Also, 
an HTML report file will be output and the H3D file will be embedded in it.   

3. For number_of_formats = specify 2.  

A second FORMAT line appears in the card image. 

4. Click H3D in the second line of the card image and select HM.  
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This specifies RADIOSS to output the results to a HyperMesh binary results file, allowing 
the results to be post-processed within HyperMesh. 

5. Click return to exit to the control cards panel. 

Notice the FORMAT button is green. This indicates the card will be exported to the 
RADIOSS input file. 

6. Click return to exit to the main menu. 

Step 13:  Export the model to a RADIOSS Bulk Data input file. 
1. On the File menu, click Export. 
2. In the Export tab, for Export Type: specify FE Model. 
3. In the File name: field, type channel_brkt_assem_loading.fem. 

Note that the extension for an RADIOSS Bulk Data input file is .fem. 

4. Click Save to export the model as an RADIOSS .fem input file. 

This exports the model as an input file for the solver specified by the current user profile. 

Step 14:  Review the contents of the file channel_brkt_assem_loading.fem.  
1. Using any text editor (Notepad, Wordpad, Vi, etc.), open the file 

channel_brkt_assem_loading.fem. 

2. Near the top of the file, notice as shown in the following image: 

• The line FORMAT HM which you specified in HyperMesh 

• The load step (RADIOSS Bulk Data SUBCASE) named pressing_step which you 
defined in HyperMesh 

• Under the load step, the load collector ids (RADIOSS load and constraint set 
identification numbers)  

 
3. Search for "FORCE". 

Notice the load set identification number for each force (RADIOSS FORCE). It is either 1 
or 2 as shown in the following image. These numbers correspond to the numbers under 
the load steps in the file. 

 
4. Search for "SPC" (HyperMesh constraint). 
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Notice the constraint set identification number for each constraint (RADIOSS SPC). It is 
2 as shown in the following image, which lists a few of the constraints. This number 
corresponds to the number under the load steps in the file. 

 
5. Search for the load collector name "pressing_load". 

Notice the load collectors pressing_load and constraints. Also, notice their collector ID 
and color ID. When the model is imported into HyperMesh, the loads are organized into 
these load collectors and have these IDs and colors. 

 
6. Close the file channel_brkt_assem_loading.fem. 

Step 15 (Optional):  Save your work. 
With the exercise completed, you can save the model as a HyperMesh file, if desired. 
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Chapter 7 

Connectors 
Analyzing an assembly of parts is a common need.   The parts in the assemblies need to be 
held together, whether by bolts, welds, rivets, or adhesives.  There are many different ways 
to model these connection types in FEA, which are specific to the type of analysis being 
done.  The connectors functionality in HyperMesh allows them to be created and managed 
easily, especially when large numbers are involved, for instance with welding.  This section 
examines the different types of connections and how to create and edit them within 
HyperMesh. 

• In this chapter, you will learn how to: 

• Weld the two front trusses to each other by creating connectors at pre-defined weld 
points. 

• Weld the two front trusses to the reinforcement plate by creating connectors between 
shell elements. 

• Weld the right rails to each other and to the front trusses by creating connectors from 
a master connectors file. 

• Apply an adhesive connection to the left rails. 

• Apply a bolted connection to the two rear trusses. 
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Connectors: What are they 
Connectors are a geometric representation of connections between entities.  The advantage 
of connectors is the ability to create multiple connections at a single time.  Hundreds or even 
thousands of connections that would normally have to be created manually, one at a time 
can be mass created, even before the part is meshed.  They can be used to create 
numerous types of connection elements such as; 
 

• Spot Welds  

• Bolts  

• Trim Masses  

• Seam Welds  

• Area Connections (Adhesives)  
 
Connectors: Terminology 

• Link Entities - The entities that are being connected 
• User can explicitly define link entities or specify a search tolerance 
• Can be components, elements, surfaces, nodes, or tags 
• Typically components are linked 

• Connector Location - Where the entities are linked 
• Nodes – created at the node location 
• Points –  created at the point location 
• Lines – created on the line 
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• The line may be split into multiple projection locations as specified by 
the offset, spacing, and density values 

• Elements – created at the element location (adhesives only) 
• Surface – created at the surface location (adhesives only) 

• Connector Realization – The creation of the finite element representation of that 
connector 

• Rigids, springs, etc., or custom configurations such as ACMs, CWELDS, etc. 
• Connector State – Whether an FE representation of a connector has been created  

• Unrealized - The initial status of the connector entity upon creation 
• Realized - The status only if creation of the FE weld representation at the 

connector was successful 
• Failed – The status if creating the FE weld representation at the connector 

was not successful 
• # of Layers – number of FE weld layers to attempt to generate for the connector 

• 2T, 3T, etc. 
• Connect When: – Specifies when the link entity information is added to the 

connector 
• Now - Allows you to add link entity information now.  For this option, you must 

select the connect what entities and num layers to successfully create a 
connector. 

• At FE Realize - The link entities to the connector are determined while 
realizing the connector.  The link entities are determined by the projections 
and proximity from the connector location.   

• Re-Connect Rule – Defines method for connector re-attachment during part 
swapping/replacement 

• None - If a link entity is deleted, the link entity is removed from the connector 
• By ID - If a link entity is deleted, the connector retains the ID of the link entity, 

and will to a new entity with that ID upon realization 
• By Name – Same as the by id rule except that the entity name is retained 

 
Connectors: Tools 

• Connectors Module 
• Spot  
• Bolt  
• Seam  
• Area  
• Apply Mass – adds a mass value to entities 

• Used to represent mass of parts that are not present in the model 
• FE Absorb – Create new connectors from existing elements of recognizable 

FE representations of welds, bolts, adhesives, etc. 
• Add Links – Add link entities to existing connectors 
• Unrealize – Delete FE representations of welds / bolts / adhesives 

associated with existing connectors 
• Compare – Checks the MCF against displayed model file 
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• Quality – Check for duplicate connectors, combines connectors, and checks 
the quality of realized elements 

• Connector Browser – Hierarchal browser that 
provides information and the ability to edit 
connectors. 

• Shows: 
 Type of Connector   
 Link Information   
 State of connector 

• Editable 
• Edit link entities, export mwf files, 

etc  
• Found in Tab Browser Area 

 
 
 

• Visualization–  Controls how connectors are displayed: 
• Color connectors by state, layers, or component 
• Visibility by state or layers (can turn the display on or off) 
• Control size of connector display 

 
 
 

 



Chapter 7: Connectors 

HyperWorks 10.0  HyperMesh Introduction 199 
Proprietary Information of Altair Engineering, Inc. 

 

Exercise 1: Connectors Introduction using Spot Connectors 
This exercise uses the model file, frame_assembly.hm. Weld the two front trusses by 
creating connectors between geometry surfaces at pre-defined weld points. 

 

 Step 1:  Retrieve and view the model file. 
1. Open the model file, frame_assembly.hm. 

2. Take a few moments to observe the model using various visual options available in 
HyperMesh (rotation, zooming, etc.). 

3. From the Preferences pull-down menu, select User Profiles. 

4. Select RADIOSS, then Bulk Data. 

5. Click OK to load the user profile. 

Step 2:  Display only the assembly, assem_1 for elements and geometry.  
1. Click the Model tab in the tab area. Or, go to the View menu and click Model Browser. 

2. Select the Model View icon, , in the Model Browser and expand the Assembly 
Hierarchy tree. 
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3. Right-click the entity selection, , and select the Elements + Geometry icon,  .   

This turns on/off both elements and geometry when performing right-click operations in 
the model browser. 

4. Right-click assem_1 and select Isolate.  

This will only display the components that are in the assem_1 assembly. 

Step 3: Load the Connector Browser. 
1. Go to the View menu and click Connector Browser. 
2. Review the layout of the Connector Browser. 

 The Connector Browser allows users to view and manage the connectors in their 
model.  The top portion of the browser is called the component window and it contains 
a listing of the components being connected with the connectors.  The lower portion is 
called the connector window and it contains a list of the connectors in the model.  The 
connectors will be grouped based on the type of connection.   

Currently there are no components or connectors listed because there are no 
connectors in the model. 
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Step 4:  Create welds between the geometry for the two front trusses at the 
pre-defined weld points. 
There are two methods for creating connectors: automatic and manual. The automatic 
approach creates and realizes connectors automatically. The manual approach allows you 
to create the connector manually, and then realize the connector manually. Realization is 
the process in which the connector creates the weld entity. 

To create connectors automatically, access the spot, bolt, seam, and area panels within 
the connectors module. To create connectors manually, go to the create and realize sub-
panels. 

1. Access the spot panel in one of the following ways: 

• Right-click in the Connector Browser in the connector window and select Create 
>> spot 

• From the main menu, select the 1D page, then select the connectors module, and 
then select spot 

• At the bottom of the Connector Browser click spot ( ) 

2. Access the spot sub-panel. 

3. Verify that the current component is Con_Frt_Truss. 

4. Switch the location: entity selector to points. 

5. Select the six pre-defined weld points by selecting points >> by collector and selecting 
the component Con_Frt_Truss. 

6. Click select. 
7. For connect what:, click comps and select the components Front_Truss_1 and 

Front_Truss_2. 

8. For connect what:, toggle elems to geom. 

9. For tolerance = specify 5.  The connector will connect any selected entities within this 
distance of itself. 

10. For type=, select weld. 

11. Click create. 

12. Click return. 

   
The six connectors are automatically created and realized (notice the message in the status 
bar). The green connectors indicate that the creation of the weld entity was successful. The 
connectors are organized as geometry (not elements) in the current component collector, 
Con_Frt_Truss. 
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 ' 

There are three states of connectors: realized (green ), unrealized (yellow ) and failed 
(red ). The color of the connectors change from yellow to green (if created manually), 
indicating they are realized into weld elements. As mentioned before, if created 
automatically they will be green immediately as there is no interim unrealized (yellow) state.   

Fixed points were added to the surfaces at the ends of the weld elements to guarantee 
connectivity between the weld elements and the shell mesh that will be created on the 
surfaces. 

   

Step 5:  Review the Connector Browser. 
1. In the connector window in the Connector Browser, click the + next to RBAR.   

This contains a listing of the six connectors just created.  They are all grouped under 
RBAR because that is the type of connector created.  Notice the ID of the connector 
under Entities, the Links of the connector, and the State of the connector.  You may 
need to increase the size of the tab area to the right to see the State column. 
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2. In the collector window in the Connector Browser, right-click Front_Truss_1 and 
select find.  

There are five different options available. Select Find.  This isolates this collector in the 
graphics area.  It also highlights the six connectors in the connectors window to 
indicate that these connectors have Front_Truss_1 as a link. 

  
3. Right-click Front_Truss_1 again, and this time select Find Attached.   

This will find the components that are attached to Front_Truss_1 through connectors.  
Notice that Front_Truss_1 and Front_Truss_2 are now both highlighted in the 
component window to indicate that they have been displayed in the graphics area. 

Step 6:  Create a shell mesh on the two front truss components. 
1. Press F12 to go to the automesh panel. 

2. Access the size and bias sub-panel. 

3. Select the mesh mode automatic. (It currently may be interactive.) 

4. Select surfs >> displayed. 

5. For elem size =, specify 10. 

6. For mesh type, select mixed. 

7. Verify that the toggle is set to elems to surf comp. (It currently may be elems to 
current comp.) 
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8. Click mesh to mesh the surfaces. 

9. Zoom into the area with a connector and see how the fixed point created from the weld 
has ensured the mesh seeding passes through the weld. 

10. Click return to return to the main menu. 

Step 7:  Display only the assembly assem_2 for elements and geometry.  
Weld the two front trusses to the reinforcement plate by creating connectors between shell 
elements at pre-defined weld points. 

  
1. Click the Model tab in the tab area. Or, go to the View menu and click Model Browser. 

2. At the top of the browser window, verify that Elements + Geometry ( ) is the current 
selection type.  

3. Right-click assem_2 and select Isolate. 

Step 8:  Create connectors between the shell mesh for the front trusses and 
the reinforcement plate at pre-defined points. 
Perform the following steps to create and realize the connectors manually. 

1. On the status bar, click the set current component and set the current collector to 
Con_Truss_Plate. 

2. Go to the Connector tab in the tab area. 

3. Right-click in the connector window and select Create >>Spot. 
4. Access the create sub-panel. 

5. For location:, select points. 

6. Select points >> by collector and select the component Con_Truss_Plate. 

7. Click select. 
8. For connect what:, select the following components: 
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• Front_Truss_1 

• Front_Truss_2 

• Reinf_Plate 
9. Click select. 
10. Also for connect what:, toggle geom to elems. 

11. Verify that num layers is set to total 2. 

12. Also verify that connect when: is set to now. 

13. Click create to create connectors at the selected weld points.   

Notice that the status bar says "8 spot connectors created with comps and links."  The 
connectors are organized into the current component collector, Con_Truss_Plate. 

  
14. Notice in the Connector Browser's connector window that these eight connectors are 

currently grouped as undefined and that the color of the connectors is yellow to indicate 
they are unrealized.   

15. Click the + next to undefined and notice the status of the eight connectors is unrealized.  
In the next step, you will realize the connector and assign a connector type. 

Step 9: Realize the connectors in the component Con_Truss_Plate into weld 
elements. 
1. Go to the realize sub-panel. 

2. Select connectors >> displayed. 

3. For type=, select weld. 

4. For tolerance =, enter 5.  

5. Verify the selection is set to mesh dependent from mesh independent. 
When the option mesh dependent is active, if the realized finite element of the 
connector is coincident to a node of the shell mesh it is being connected to, the nodes 
are equivalenced. If there are no suitable nodes present, this option will partition the 
mesh accordingly to ensure the mesh seeding passes through the weld point.  

6. Click realize to realize the selected connectors into weld elements. 

  
7. Review the Connector Browser.  Notice the following: 

• Reinf_Plate is now a component listed in the component window. 
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• The eight connectors that were just realized are now grouped under RBAR in the 
connector window instead of undefined as we just assigned the connector type. 

8. Zoom into the eight connectors that were just realized.  Notice how the mesh was 
partitioned to ensure the mesh seeding passed through the weld points. 

9. Click return to return to the main menu. 

 



Chapter 7: Connectors 

HyperWorks 10.0  HyperMesh Introduction 207 
Proprietary Information of Altair Engineering, Inc. 

 

 

 

Step 10: Display only the assembly assem_3 for elements and geometry.  
10. 1. Click the Model tab in the tab area. Or, go to the View menu and click Model 

Browser. 

11. 2. At the top of the browser window, verify that Elements + Geometry ( ) is the 
current selection type.  

12. 3. Right-click assem_3 and select Isolate. 

Step 11:  Create connectors to connect the right rails to each other and to the 
front trusses by importing a master connectors file. 
1. Access the Import Tab in one of the following ways: 

• From the Pull-down menu, select File, then select Import. 

• In the Standard Toolbar select Import ( ). 

2. For Import type, select Connectors. 

3. For File type, select Connectors. 
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4. Click Open ( ) and import the file, rails_frt_truss.mwf. 

5. Click Apply.   

It will take a few seconds for the connectors to be imported.  The connectors are 
automatically created and are organized into the new component, CE_Locations. 

Step 12:  Realize the connectors in the component CE_Locations into weld 
elements. 
1. In the status bar, click set current component and set the current component collector 

to CE_Locations. 

2. Click the Connector Tab.  Right-click in the connector window and select Create >> 
spot. 

3. Access the realize sub-panel. 

4. Select connectors >> displayed. 

5. Verify type= is set to weld. 

6. Verify tolerance = is set to 5. 

7. Verify mesh dependant is selected. 

8. Click realize to realize the selected connectors into weld elements. 

9. Click return to return to the main menu. 
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Step 13:  Display only the assembly assem_4 for elements and geometry. 
1. Click the Model tab in the tab area. Or, go to the View menu and click Model Browser. 
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2. At the top of the browser window, verify that Elements + Geometry ( ) is the current 
selection type.  

3. Right-click assem_4 and select Isolate. 

Step 14:  Create a new component collector to hold new connectors. 
1. Enter the component collectors panel by one of the following ways: 

• From the collectors toolbar, click Components ( ) 

• From the Pull-down menu, select Collectors,  then select Create and then select 
Components 

2. Verify you are in the create sub-panel. 

3. For name = specify CE_Locations_Dup. 

4. Select a color for the component. 

5. Toggle property= to <property blank>. 

6. Click create to create the component. 

7. Click return to return to the main menu. 

Step 15:  Duplicate the connectors created from the master connectors file 
and reflect them. 
1. Enter the reflect panel by one of the following ways: 

• From the Pull-down menu, select Connectors, then select Reflect and then select 
Connectors 

• From the main menu, select the Tool page, then select reflect 
2. Verify the entity selector is set to connectors. 

3. Using the model browser, turn on and display the component, CE_Locations. 

4. Select connectors >> by collector and select CE_Locations. 

5. Click connectors >> duplicate >> current comp. 

The displayed connectors are duplicated and the duplicates are organized into the 
current component, CE_Locations_Dup. 

6. Set the plane selector to x-axis. 

This is the axis normal to the plane of interest. 

7. Click B twice to specify a base node to reflect about. 

8. Click x=. 

The fields for x=, y=, and z= are activated. By default, their value is 0.000, which is the 
base point you want to reflect about. 

9. Click return to return to the reflect panel. 

10. Click reflect to reflect the connectors and notice they are unrealized (yellow). 



Chapter 7: Connectors 

HyperWorks 10.0  HyperMesh Introduction 211 
Proprietary Information of Altair Engineering, Inc. 

 

11. Click return to return to the main menu. 

Step 16:  Update the connectors for the left rails to link them to the left rail 
components. 
1. Enter the Connector Browser. 
2. Expand the folder for RBAR in the connector window. 

3. Click State to sort the connectors by their state.   

You may need to increase the size of the Tab Area to the right to see the State column.  
Notice how all the realized connectors are now at the top of the list. 

4. Click State again so that all the unrealized connectors are at the top of the list. 

5. Left-click the first connector in the list under the Entities column.  Scroll down to the last 
unrealized connector in the list.  While holding the SHIFT button, left-click the last 
unrealized connector in the list. This will select all the unrealized connectors in the list.  
Verify that this is the case. 

6. Right-click under Entities and select Update Link.  This brings up the update window 
under the connector window in the Connector Browser. 
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7. Review the entries in the Link1 and Link2 columns. 

8. Notice that the connectors have the links comp Right_Rail_1 and comp Right_Rail_2. 
This data is from the master connectors file that you imported. These links need to be 
updated to reflect the two left rails. 

9. Set Link Type to comps under Search in the update window. 

10. Click in Link Select under Search.  This brings up a component selector in the panel 
area. 

11. Click component and select the component, Right_Rail_1. 

12. Click proceed.  This updates the Connector Browser so now the Link Select is set to 
Right_Rail_1 under Search. 

13. Set Link Type to comps under Replace. 

14. Click in Link Select under Replace.  This brings up a component selector in the panel 
area. 

15. Click component and select the component, Left_Rail_1. 

16. Click proceed.  This updates the Connector Browser so now the Link Select is set to 
Left_Rail_1 under Replace. 

  
17. Click Update to update the connectors' links. 

18. Repeat #9 through #19, except search for the Right_Rail_2 component and replace it 
with the Left_Rail_2 component. 

19. Scroll through the list of unrealized connectors to make sure that no connector is linked 
to the right rail components. 

20. Click the X next to Update to close the update window. 

Step 17:  Realize the connectors in the component, CE_Locations_Dup, into 
weld elements. 
1. Go to the spot: realize sub-panel. 

2. Select connectors >> by collector and select the component, CE_Locations_Dup. 

3. Verify type= is set to weld. 
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4. Verify tolerance = is set to 5. 

5. Click mesh dependent option is active. 

6. Click realize to realize the selected connectors into weld elements. 

Step 18:  Verify that all connectors are realized and identify the pairs of 
adjacent connectors. 
1. In the connector window of the Connector Browser, verify that the RBAR folder is 

expanded. 

2. Scroll through all the connectors.  Note that the State column indicates that all of the 
connectors are realized. 

3. Zoom into one of the two areas where the front trusses are connected to the rail 
components. 

Note that at these two areas, there are pairs of adjacent connectors.  

4. Click Visualization Options ( ) from the visualization toolbar. 

5. On the Connectors tab, select Layer for the color by: option. 

6. While still in the visualization dialog, notice under layers that 2t (two thickness) is 
purple. 

The connectors are now colored purple. This means each of these connectors link two 
components. 

Because the pairs of connectors create a series of two weld elements, you can combine 
each pair into a single connector, which links the three components together. 

Step 19:  Isolate the pairs of adjacent, 2t connectors identified in the previous 
step.  
1. From the model browser, turn off the display for all geometry components. 

2. Enter the find panel by doing one of the following: 

• From the Pull-down menu, select Edit, then Find 

• From the main menu, select the Tool page, then select find 

3. Select the between sub-panel. 

4. Switch the entity type to connectors. 

5. Switch the entity selector to comps. 

6. Select the components Front_Truss_1 and Front_Truss_2. 

7. Click select. 
8. Click find to find the six connectors between these components. 

9. Next to the comps selector, click   to reset the selection. 

10. Select the components, Front_Truss_1 and Right_Rail_1. 
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11. Click find to find the three connectors between these components. 

12. Click  . 

13. Select the components Front_Truss_1 and Left_Rail_1. 

14. Click find to find the three connectors between these components. 

15. Click return to return to the main menu. 

Step 20:  Unrealize the displayed connectors.  
1. Access the unrealize panel by doing one of the following: 

• From the Pull-down menu, select Connectors, then Unrealize 

• From the main menu, select the 1D page, then select connectors, then select 
unrealize 

2. Select connectors >> displayed.   

Notice the status bar displays "12 connectors added by 'displayed'.  Total selected 12." 

3. Click unrealize to unrealize the connectors. 

The weld elements associated to these connectors are deleted. 

4. Click return to return to the main menu. 

Step 21:  Combine the pairs of adjacent 2t connectors into 3t connectors. 
1. Enter the connector quality panel by doing one of the following: 

From the Pull-down menu, select Connectors, then select Check, then Connectors, 
then Quality 
From the main menu, select the 1D page, then select connectors, then quality 

2. In the connectors (unrealized) sub-panel, select connectors >> displayed. 

3. For tolerance = specify 5. 

4. Click preview combine. 

The status bar displays the message, "12 connector(s) found that need to be 
combined." 

5. Click combine to combine the connectors. 

The status bar displays the message, "6 connectors deleted."  Also notice that the 
connectors have now turned a dark blue color to indicate that they have 3 layers. 

6. Click return to return to the main menu. 

Step 22:  Realize the 3t connectors in the component, Con_Frt_Truss, into 
weld elements. 
1. Set the current component to Con_Frt_Truss. 

2. Enter the spot: realize sub-panel. 
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3. Select connectors >> displayed. 

4. Verify element config: is set to weld. 

5. Verify tolerance = is set to 5. 

6. Toggle mesh dependent option to be active. 

7. Click realize to realize the connectors. 

8. Click in the Connector Browser.  Scroll down through the list in the connector window 
to see that there are now three links for the six connectors we just updated. 

9. Click return to return to the main menu. 

10. Click Visualization Options ( ) from the visualization toolbar. 

11. On the Connectors tab, select State for the color by: option. 

Step 23: Display only the assembly assem_5 for elements and geometry. 
1. Click the Model tab in the tab area. Or, go to the View menu and click Model Browser. 

2. At the top of the browser window, verify that Elements + Geometry ( )  is the current 
selection type. 

3. Right-click assem_5 and select Isolate. 

Step 24: Create connectors from existing ACM welds. 
Use the fe absorb panel to obtain connectors from the existing ACM welds (elements) in the 
component, Con_Rear_Truss. 

1. Enter the Automated Connector Creation and FE Absorption dialog in one of the 
following ways: 

• From the Pull-down menu, select Connectors, then select FE Absorb 

• At the bottom of the Connector Browser click FE Absorb GUI ( ) 
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2. Set FE Configs: to custom. 

3. Set FE Type: to optistruct 69-71 acm. 

4. Toggle Elem filter: from All to Select. 
5. Click the Elem filter: Elements selector twice. 

A HyperMesh panel menu with an elems selector appears. 

6. Select elems >> by collector and select the component, Con_Rear_Truss. 

7. Click proceed to return to the dialog. 

8. Activate the Move connectors to FE component option. 

9. Click Absorb to absorb the elements into connectors. 

Connectors are generated at the locations of the ACM welds. They are realized and are 
2t connectors. Also, the connectors are organized into the Con_Rear_Truss, the same 
component to which the ACMs belong. 

10. Click Close to close the dialog. 
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Exercise 2: Creating Area Connectors 
In this tutorial, you will learn how to: 

• Apply an adhesive connection to the left rails. 

This exercise uses the model file, frame_assembly1.hm.   Area connectors must be 
meshed in order to work properly. When the connector’s location is existing FE mesh elems, 
the connector automatically gets meshed to match the elements chosen. However, after 
creating an area connector on surfs, lines, or along nodes, you must then use the automesh 
options (which display when you select one of these locations types) to create a mesh on 
the connector area. 

area Create and realize bolt connectors in a single process. 

create Create, but do not realize, area connectors. 

realize Create FE representations of previously-created area connectors. 

Step 1:  Retrieve and view the model file. 
1. Open the model file, frame_assembly1.hm. 

2. Take a few moments to observe the model using various visual options available in 
HyperMesh (rotation, zooming, etc.). 

3. Go to the Preferences menu, click User Profiles. 

4. Select Radioss, then Bulk Data. 

5. Click OK to load the user profile. 

Step 2: Load the Connector Browser. 
1. Go to the View menu and click Connector Browser. 
2. Review the layout of the Connector Browser. 

The Connector Browser allows users to view and manage the connectors in their 
model.  The top portion of the browser is called the component window and it contains 
a listing of the components being connected with the connectors.  The lower portion is 
called the connector window and it contains a list of the connectors in the model.  The 
connectors will be grouped based on the type of connection. 

Currently there are no components or connectors listed because there are no 
connectors in your model. 

Step 3:  Create an adhesive connection between component, Left_Rail_1 and 
Left_Rail_2 on the top flange. 
1. From the model browser, display only the elements for components, Left_Rail_1 and 

Left_Rail_2. 

2. Zoom into an area displaying the two flanges and inspect the elements to be joined. 
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3. Create a new component by right-clicking in the Model Browser and select Create >> 
Component. Call it, Left_Rail_Adhesive. Ensure the new component is the current 
component.  

4. Access the area panel in one of the following ways: 

• Right-click in the Connector Browser in the connector window and select Create >> 
area. 

• From the main menu, select the 1D page, then select the connectors module, then 
select area. 

• At the bottom of the Connector Browser click area ( ). Access the area sub-
panel. 

5. Verify that location: is set to elems. 

6. Pick one element on the top flange of Left_Rail_1. The element should be highlighted. 

7. Click elems and select the by face option – the whole flange should be highlighted. 

 
8. Next, select comps and pick Left_Rail_1 and Left_Rail_2 for connect what 
9. Set tolerance= 10.  The connector will connect any selected entities within this distance 

of itself. 

10. Click type= and select adhesives. 

11. Verify that the adhesive type is set to shell gap – this option projects directly to the shell 
component and takes no account of the thickness of the shell component.  
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12. Click create. 

13. Inspect the new adhesive, note that an area connector has been created, and then click 
reject. 

14. Repeat  #5 – #12, and select the type to (T1+T2)/2 (instead of shell gap) and increase 
the density= 3. This type takes into account the thickness of each shell part and 
increases the number of hexas through thickness from 1 to 3.  

 
For the other set of flanges you will manually create an area connector and mesh it accordingly. 

Step 4:  Create an adhesive connection between component, Left_Rail_1 and 
Left_Rail_2 on the bottom flange. 
1. Verify that you are still in the area panel. 

2. Select nodes for the location. Click node list and select by path. Select the row of 
nodes on the outer flange on part, Left_Rail_1 by first selecting the left most node on 
the bottom flange of Left_Rail_1 and then selecting the right most node on the bottom 
flange (see following image). 
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3. Define width = 10 

4. Define offset = 3 

5. Select comps, Left_Rail_1 and Left_Rail_2. 

6. Click create. 

 
The default mesh size for these mesh independent area connectors (when choosing by 
nodes/lines/surfs) is 10. There is, however, an option to control the mesh size. 

7. Go to the edit sub-panel. 

 
8. Select the newly created area connector.  

9. Select the element size= 3. 

10. Click mesh.  
Note the connector unrealizes if there is a pre-exising mesh. 

11. Access the realize sub-panel and pick the connector. 

12. Change the type from (T1+T2)/2 to const_thickness and enter 0.3. 
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13. Click realize. 

Inspect the new adhesive created. Note when creating area connectors from elements it 
will automatically mesh the area connector using the current mesh. If the area connector 
is created from nodes, lines or surfaces then a manual mesh can be applied if the 
default is unsuitable from the area sub-panel. 

 
14. Return to the main menu. 
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Exercise 3: Creating Bolt Connectors 
In this tutorial, you will learn how to: 

• Apply a bolted connection to the two rear trusses. 

This exercise uses the model file, frame_assembly2.hm. The bolt panel creates 
connectors based on holes within the connected components, using spiders or washers at 
each end of an RBE connector. When the bolt panel is active, only bolt-type connectors 
display in the graphics area; graphics for other connector types are suppressed until you 
exit the panel. The bolt panel contains three sub-panels: 
 

bolt Create and realize bolt connectors in a single process. 

create Create, but do not realize, bolt connectors. 

realize Create FE representations of previously-created bolt connectors. 

Step 1:  Retrieve and view the model file. 
1. Retrieve the model file, frame_assembly2.hm. 

2. Take a few moments to observe the model using various visual options available in 
HyperMesh (rotation, zooming, etc.). 

3. Go to the Preferences menu, click User Profiles. 

4. Select Radioss, then Bulk Data. 

5. Click OK to load the user profile. 

 

Step 2:  Display only the assembly, assem_5 for elements and geometry.  
1. Click the Model tab in the tab area. Or, go to the View menu and click model browser. 
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2. Select the Model View icon, , in the model browser and expand the Assembly 
Hierarchy tree. 

3. Right-click the entity selection icon,  and select Elements + Geometry ( ).   
This turns on/off both elements and geometry when performing right-click operations in 
the Model Browser. 

4. Right-click assem_5 and select Isolate. This will only display the components that are in 
the assem_5 assembly. 

5. Set Con_Rear_Truss to be the Current Component by right-clicking it in the Model 
Browser and selecting Make Current. 

Step 3: Load the Connector Browser. 
1. Go to the View menu and click Connector Browser. 
2. Review the layout of the Connector Browser. 

The Connector Browser allows users to view and manage the connectors in their 
model.  The top portion of the browser is called the component window and it contains 
a listing of the components being connected with the connectors.  The lower portion is 
called the connector window and it contains a list of the connectors in the model.  The 
connectors will be grouped based on the type of connection.   

Currently there are no components or connectors listed because there are no 
connectors in your model. 

Step 4:  Create a bolt connector. 
1. Access the bolt panel in one of the following ways: 

• Right-click in the Connector Browser in the connector window and select Create >> 
bolt. 

• From the main menu, select the 1D page, then select the connectors module, and 
then select bolt. 

• At the bottom of the Connector Browser click bolt ( ) 

2. Verify that location is set to nodes and select the node on the edge of the hole in the 
component, Rear_Truss_1. 
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3. Pick the components to connect Rear_Truss_1 and Rear_Truss_2. 

4. In the tolerance= field, type 50. 

The connector will connect any selected entities within this distance of itself. 

5. Set type= to bolt (general).  

Re-realizing the connector will allow you to see the different bolt types. 

6. In the max= field, type to 60 to ensure that the diameter of the picked hole will be 
captured. 

7. Click create. Ensure the display of the current component is turned on. 

8. Click return to access the main menu. 

 



Chapter 7: Connectors 

HyperWorks 10.0  HyperMesh Introduction 225 
Proprietary Information of Altair Engineering, Inc. 

 

 


	01_Cover
	02_contacts
	03_TOC
	04_TOC
	05 - c1s1 HM- 1000 Getting Started with HyperMesh
	06 - c1s2 HM- 1010 Opening and Saving Files
	07 - c1s3 HM- 1020 Working with Panels
	08 - c1s4 HM- 1030 Organizing a Model
	09 - c1s5 HM- 1040 Controlling the Display
	10 - c2s1 HM- 2000 Importing and Repairing CAD
	11 - c2s2 HM- 2010 Generating a Midsurface
	12 - c2s3 HM- 2020 Simplifying Geometry
	13 - c2s4 HM- 2030 Refining Topology to Achieve a Quality Mesh
	14 - c3s1 HM- 3100 AutoMeshing
	15 - c3s2 HM- 3300 Checking and Editing Mesh
	16 - c3s3 HM- 3140 Batch Meshing
	17 - c4s1 Solid Editing and Meshing
	18 - c5 HM- 3200 Tetrameshing
	19 - c6s1 HM- 4000 Setting up Loading Conditions
	20 - c3s2 HM- 4010 Formatting Model for Analysis
	21 - HM- 3400 Creating Connectors
	22_c4.1 HM- 3400 Creating Connectors
	23_c4.2 HM- 3410 Creating Area Connectors (Repaired)
	24_c4.3 HM- 3420 Creating Bolt Connectors

	Class Title: HyperMesh Introduction
	Subtitle: Pre-processing for Finite Element Analysis


